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Adaugare utilizatori

Creare manuala de conturi

Autentificarea manuala este activata in mod implicit in platforma.

Locatia plugin-ului de autentificare manuala: Site Administration > Plugins > Authentication > Manage

authentication

Manage authentication

Available authentication plugins

Tast
Name Users Enable Up/Down Settings settings Uninstall
Manual 21 Setlings
accounts
Mo login 0 Settings
Email-based 4] @ Setlings Uninstall
self-
registration

Un administrator sau manager poate crea manual noi conturi de utilizator in: Site administration >
Users > Accounts > Add a new user

- General
Lisarmiames=
Choosa an aumenticabon mManual accounts L
metnad

@
Suspended account (5

Generate password and nobly
user

The password must have &t least B characters, al kast 1 digit(s), at least 1 lower case
letteris), at least 1 upper case letter(s), at keast 1 non-alphanumenc character|s)

MHew password (F) [ Unemask

Fore password change (5 O]

First name*=

Surname*

Emanl address*®
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Sectiunea General
Username / Utilizator

Utilizatorul va folosi acest nume de utilizator pentru a se conecta in platforma. E obligatoriu sa fie unic.
Authentication method / Metoda de autentificare

Setarea specifica modul in care platforma de e-Learning va verifica daca parola specificata de utilizator
este corecta.

Conturile create de un administrator utilizeaza metoda Manual Accounts, iar conturile pe care
utilizatorii si le-au creat utilizand metoda de auto-inregistrare prin e-mail folosesc metoda E-mail based
self-registration.

Suspended account / Cont suspendat
Conturile de utilizator suspendate nu se pot autentifica sau utiliza serviciile platformei.
Generate password and notify user / Genereaza parola si anunta utilizatorul

Platforma va genera o parola temporara si va trimite un e-mail utilizatorului cu instructiuni despre
logare si schimbarea acesteia.

Password / Parola noua

Aceasta este parola utilizatorului. Un utilizator Tsi poate schimba parola prin meniul: User menu >
Preferences.

First Name / Prenume
Surname / Nume

Email address / Adresa email

Notificarile de resetare a parolei, notificarile de la forumurilor si alte mesaje sunt trimise la aceasta
adresa de e-mail de pe platforma.

Adresele de email duplicate nu sunt permise pe platforma in mod implicit. Acesata setare se poate
modifica daca se activeaza ,Allow accounts with the same email” in Site administration > Plugins >
Authentication > Manage authentication. Acest lucru poate duce la probleme de securitate sau de
confidentialitate, de exemplu, e-mailul de confirmare a parolei schimbate.

Email display / Afisare email

Page4

Aceasta setare controleaza cine poate vedea adresa de email a utilizatorului.
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City/town / Oras

Country / Tara

Timezone / Fus orar
Language / Limba preferata

Description / Descriere

Auto-inregistrare pe baza de email

Acest plugin le permite utilizatorilor sa-si creeze propriile conturi prin intermediul butonului ,,Create
new account” din pagina de conectare la platforma.

Activarea plugin-ului de auto-inregistrare pe baza de email
1. n Site administration > Plugins > Authentication > Manage authentication selectati iconita cu
ochi din dreptul plugin-ului de auto-inregistrare
2. Selectati,Email-based self-registration” din meniul drop-down ,Self registration” din sectiunea
»,Common settings” (jos In pagind, dupa tabelul cu plugin-urile de autentificare)
3. Salvati modificarile.

Atentie!l: Activarea auto-inregistrdrii le poate permite spammer-ilor sd isi creeze conturi pe platforma
pentru a utiliza forumu-urile, inregistrdrile pe blog etc. pentru spam. Acest risc poate fi redus prin
limitarea auto-inregistrdrii la anumite domenii de e-mail cu setarea acelor domeniilor de e-mail permise
in sectiunea Site administration > Plugins> Authentication > Manage authentication. De asemenea,
auto-inregistrarea poate fi activatd pentru o perioadd scurtd de timp pentru a permite utilizatorilor sa
isi creeze conturi, apoi sd fie dezactivatd ulterior.

Sfaturi:

e Verificati in mod regulat lista de utilizatori pentru nume si email-uri suspecte si / sau utilizatori
din sistem care nu sunt inscrisi la cursuri.

e Este posibil ca utilizatorii potentiali sa nu primeasca e-mailul de confirmare a contului, datorita
faptului ca acesta a ajuns in folder-ul spam, sau a fost refuzat de serverul de email, sau adresa
de e-mail introdusa este invalida etc. Aceste conturi pot fi confirmate manual de catre un
administrator.
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Managementul utilizatorilor
Stergerea unui cont

Un cont poate fi sters facand clic pe iconita de stergere din dreptul numelui utilizatorului.
Atentie: Stergerea unui cont duce la stergerea permanentd a datelor utilizatorului. Daca doriti sa
pastrati datele, e recomandat sa suspendati, in schimb, contul utilizatorului.

Suspendarea unui cont

Un administrator poate suspenda un cont prin selectarea iconitei ochi din dreptul contului utilizatorului
respectiv, in lista de utilizatori.

Administratorul mai poate suspenda un cont prin bifarea optiunii ,Suspended account” din pagina ,Edit
profile” a contului respectiv.

Dashboard Users Alice Hill Preferences User account Edit profile
NAVIGATION =
Dashboard Alice Hill
= Site home
» Site pages
» My courses ~ General
v Users
+ Alice Hill
» View profile Username*
» Forum posts alicehill322
» Blogs
* Messages Choose an authentication method (3
= Notes
s Grades No login v
» Courses

Suspended account (%)

De asemenea administratorul mai poate selecta ,No Login” din meniul drop-down , Choose an
authentication method setting” tot din pagina de profil a utilizatorului. Diferiti utilizatori trebuie sa aiba
adrese de e-mail unice in profilul lor, chiar si atunci cdnd e-mailul nu este activat. Cand se utilizeaza
setarea ,,No Login”, e-mail-ul contului nu poate fi reutilizat pentru a crea un alt cont.

Actiuni Tn masa asupra utilizatorilor

Pentru a efectua actiuni in masa asupra utilizatorului accesati Site administration > Users > Accounts >
Bulk user actions. Administratorii pot sa selecteze utilizatorii prin crearea unui filtru si apoi sa efectueze
oricare dintre urmatoarele actiuni:

Telefon: +40 0262 226 778 » Fax: +40 0262 226 778
WEB: http://www.holisun.com e E-mail: info@holisun.com

Page6




we bring you the future HOL'SU N \}
I
www.holisun.com

e Sa confirme conturile create prin auto-inregistrare pe baza de email, care nu au fost confirmate
de utilizator.

e Sa trimitda un mesaj

e Sa stearga conturi

e Sa afiseze lista cu acei utilizatori pe o pagina

e Sa descarce datele utilizatorilor intr-un fisier

e Sa forteze utilizatorii sa isi schimbe parolele

e Sa adauge utilizatorii intr-o cohorta

Pentru a efectua o actiune in masa asupra utilizatorilor
1. Dacali cunoasteti, alegeti utilizatorii din lista disponibila sau faceti click pe ,Show more” pentru
a vedea mai multe optiuni de filtrare.
2. Utilizatorii pot fi filtrati in functie de nume, prenume, adresa de e-mail, orasul, ultima
autentificare, username, tipul de inregistrare.
Selectati utilizatorii din lista.
Alegeti un filtru din meniul drop-down.
Faceti clic pe butonul ,Add filter”.
Selectati din caseta din stdnga acei utilizatori de care aveti nevoie si mutati-i Tn caseta din

o n AW

dreapta.
7. Din meniul drop-down ,,With selected users...”, alegeti actiunea pe care doriti sa o efectuati,
apoi faceti click pe ,,Go”.

User it name | contams [
Sumame
doesn’t contan
First name s equal Yo l

starts wih
Email 30dress” | onds with

Citytown r?,".’.",ﬁ.'),—_l
Country [rs any vaue :J[ need KIngaon =l
Confrmea” [any vane »]
Course role* [any rowe =l any category =
System roie m
Frstaccess” Mg aned _” 100K _-_” -
Msvetoref ¢« [Octiter =] [2017 =7 Never nciuded User fUl name | contans |
Last access” Mg ,n,,f _] | Oxtee _] [2om _.] sumame* | contans =]
s vetoref T =] [0 = _Jrhrvﬂ nciuded Frtrame’ | comans -
Lastiogin® [Misamed t ] [Ocioes BIE Emadl aoress’ | comans il
Ms bdrx:{_] r—j rﬁr Never nciuded Cityvosn® | contans =]
Last modified” s anﬂf _-_] [octoee _] B . Coumry* | is any vaios 5]
s betore T ] [Octoter 2] l—_-]r""?' ncluded Coramed” | any vake []
Usemame” [ contains | Suspenaed acount’ | sy vake [v]
Authenticabon” [any vane = Profe’ | any teid [3] | contains -
Add fiter | Course 1ok " | any role [] any canegory [+

Telefon: +40 0262 226 778 » Fax: +40 0262 226 778
WEB: http://www.holisun.com e E-mail: info@holisun.com

Page 7



we bring you the future HOL'SU N \3
I
www.holisun.com

Users in st

Users (P Avasatie [a5 sers (35) =] Setected [ Ay sewctios (75) 2]
| A Bromn Brgme Baroot
{Anne YWoaeconde Cheryt Cole
| Ashioy Rec Cows Bk
| Barbara Winasor Dareid Beckham
{Bngtte Bardol David Cameron
|Cnenyt Coe Dawvid Tennant
| Chets Black Ed WaDag
| Darvid Beckham
| Dl Carmeron
| Dot Tennant
| E0 Mmtana
|Feame Cofton
| Fidel Castro
|Goorpe Cloomey = =

Sewectea user 18t @ Add 10 seiecton| Remove om selecton |

A3 3| Remove )

Wah selecied users m Ga

Choose
Contim

Desete
Dspiay on page
Download

| Forte passwoed change

Cohorta de utilizatori
Despre Cohorte

Cohortele sunt grupuri la nivel de site sau la nivel de categorie de curs. Scopul cohortelor este de a
permite tuturor membrilor cohortei de a fi usor inscrisi la un curs. Acest lucru se poate face folosind
»Cohort sync”, care, dupa cum sugereaza si numele, sincronizeaza apartenenta la cohorta cu inscrierea
la curs. Tn mod alternativ, o cohortd mai poate fi inscrisd manual la un curs.

Crearea unei cohorte
Cohortele pot fi create de catre administratorii platformei.

1. Accesati Site administration > Users > Accounts > Cohorts

Add new cohort

System cohorts All cohorts Add new cohort Upload cohorts

Name*

Students 2015

Context

System v

Cohort ID

Visible ()

v Set this as hidden if you do not
want teachersto see it

Description

Telefon: +40 0262 226 778 » Fax: +40 0262 226 778
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2. Selectati tab-ul ,Add new cohort”

3. Retineti ca, in lista afisata, puteti alege intre a face cohorta disponibila la nivelul ,sistemului”
site-ului sau la nivelul unei categorii de curs anume.

4. Tn mod implicit, cohortele sunt vizibile pentru utilizatorii cu rol de profesor, dar dezactivarea
optiunii , Visible” inseamna cd nu sunt disponibile pentru profesori, pentru a le utiliza n
cursurile lor.

5. Completati detaliile si salvati modificarile.

6. Selectati link-ul pentru ,,Assign” din dreptul numelui cohortei, din lista de cohorte disponibile.

Name Cohort ID Description Cohortsize Source Edit
Teaching staff 2014-5 T1 89 Created manually @ X # @&
Admin staff Al 45 Created manually @« X € @

7. Selectati utilizatorii potentiali din lista afisata, apoi faceti click pe butonul ,,Add”.

Adaugarea utilizatorilor intr-o cohorta in masa
Accesati , Site administration > Users > Accounts > Bulk user actions”.
Gasiti utilizatorii prin setarea unui filtru.

Adaugati utilizatorii din lista disponibila in lista celor selectati.
Selectati ,Add to cohort” cu utilizatorii doriti.

PwnNPR

Cautarea cohortelor
Cand o platforma are un numar mare de cohorte, se pot introduce cuvinte cheie in caseta ,Search
cohort” pentru a cduta sau filtra cohorte disponibile.

System: available cohorts (12)

home System cohorts All cohort Add new cohon Uplead cohorts

AN e Soarch cohort

Courses
Search
= Category Name CohortID Description Cohortsize Source Edit
» My profile settings System Teaching staff 20145 89 Created manually X 0 2
* Site administrasion Admin staff 45 Created manually X oA
& Notific
Advanced 03 5 Craat anually % ]
£ Rec ancad 0 1 Created manualh X o 2
& Advary T . p
o - Beginners 01 20 Created manually X o 2
v Usars
* Accounts Languages  Intermadiate 02 20 Created manually X oA
£ Browse list of users
i London contingent 37 Created manually X ¢ A
J Humanitie Mentors 1" Craated manually X 0 2
P ne Science Paris contingent 7 Created manually y)
£ User profile fields
£ Humanithe: Das10 T Created manually
£ Cohorts mar s Pastoral 3 Created manual X 02
& Upload users Humanties Sodal 83 Created manually X © 2
& Jpload user pictures
» Parmissions System Speing 2015 38 Createdmanualy x o 2
» Courses
System Vinter 2014 25 Created manually X o A

* Grades

*» Badges
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Cohorte la nivel de categorie
Cohortele care au fost create la nivel de categorie de curs, pot fi localizate selectdnd categoria
corespunzatoare, iar apoi facand click pe link-ul ,,Cohorts” din Actions Menu > Cohorts.

Se mai poate accesa pagina Site administration > Courses > Manage courses and categories si
selectarea Action Meniu > Cohorts, din dreptul categoriei respective.

Inrolarea unei cohorte la un curs
Exista doua modalitati pentru a inrola o cohorta la un curs.

1. Cohort sync
2. Inrolarea manual3 a cohortei

Folosind Cohort sync, daca utilizatorii sunt adaugati sau eliminati mai tarziu din cohortd, acestia sunt
automat inscrisi sau eliminati din curs.

Tnrolarea manual3 a cohortei este o actiune unic. Ad3dugarea sau eliminarea ulterioar a utilizatorilor
cohortei nu are nici un efect in ceea ce priveste inscrierea la curs.

Inrolarea manuali a unei cohorte

Pentru inrolarea manuala a tuturor membrilor unei cohorte la un curs:

1. Mergeti la sectiunea Participants din cadrul unui curs
2. Click pe butonul, Enrol users” si mai apoi selectati o cohorta din meniul cu cohortele disponibile.
3. Selectati butonul , Enrol selected users and cohorts”

Roluri si permisiuni

Un rol este o colectie de permisiuni definite pentru intregul sistem, pe care il puteti atribui anumitor
utilizatori, in contexte specifice. Combinatia de roluri si context defineste capacitatea unui utilizator
specific de a face ceva pe orice pagina. Cele mai uzuale exemple sunt rolurile cursantului si profesorului
in contextul unui curs.

Roluri standard

Site administrator
Administratorii platformei au drepturi totale in platforma.

Utilizatorilor li se poate atribui rolul de administrator de platforma de catre un alt administrator in: Site
administration > Users > Permissions > Site administrators dar rolul in sine nu poate fi editat (sau sters!).

Page 1 0
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Nu este recomandat sa aveti multi administratori pe platforma dumneavoastra. O buna practica este
sa aveti doar unul sau doi, iar celorlalti utilizatori sa li se atribuie rolul de Manager, cu permisiunile care
le sunt necesare.

Manage site administrators

Current site administrators Users

Main administrator (1)

Mary Cooch (admin RNG_—_—_————

K <4 Acd

Gearge gadams, gadams@wt
>';‘,‘ :: rE nown {(Woo
Remove »
Set main admin
LeDex vens (rst. rst WA ¢ ;\

Search Search

Manager

Rolul de Manager le permite in mod implicit, utilizatorilor care au atribuit acest rolul, sa acceseze
cursurile si sa le modifice, precum si sa indeplineasca anumite sarcini de nivel administrativ legate de
cursuri, utilizatori, setari de note etc.

Spre deosebire de rolul de administrator, rolul Manager este un rol, ale carui permisiuni le puteti edita,
dar care este similar cu Site administrator (dar mult mai sigur de utilizat) datorita permisiunilor sale
multiple implicite.

Bunele practici de utilizare a platformei recomanda mai de graba atribuirea administratorilor rolul de
Manager, decat ce de Site administrator.

Prin urmare, rolul de Manager permite unui administrator de platforma sa acorde drepturi multiple
asupra platformei, celorlalti, carora li se atribuie un rol de Manager, dar fara a fi necesar sa li se acorde
permisiuni complete pe platforma.

Atribuirea rolului de Manager la nivel de platforma

Puteti atribui cuiva rolul Managerului in platforma (pentru a le permite, de exemplu, sa adauge
utilizatori noi), accesand Site Administration > Users > Permissions > Assign system roles selectarea
rolului Manager si selectarea utilizatorul ales.

Cand faceti acest lucru, utilizatorii din acest rol vor avea acces doar la unele dintre elementele din Site
administration. Acestia nu au acces la zone precum Security, Server, Plugins, Appearance, sau Advanced
Features, ce sunt accesibile doar grupului de utilizatori cu rolul de Site administrator. Acestia au in

Page 1 1
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schimb acces la majoritatea setdrilor si instrumentelor pentru managementul utilizatorilor, cursurilor
si a notelor.

Un utilizator cu rolul de Manager are posibilitatea de a atribui altor utilizatori rolul de Manager la nivel
de platforma. De asemenea acesta mi are posibilitatea de a edita permisiunile rolului de Manager.

Atribuirea rolului de Manager la nivel de Categorie

Rolul Manager poate fi, de asemenea, atribuit la nivel de categorie, mai degraba decat la nivel de
platforma.

Faceti acest lucru daca doriti ca un utilizator sa poata avea acces la toate cursurile dintr-o singura
categorie si sa le gestioneze, dar nu doriti sa aiba acces la niciunul dintre instrumentele din Site
administration.

Accesati: Site administration > Courses > Manage courses and categories > selectati o categorie >
Actions meniu > Assign roles > Manager > selectati un utilizator > Add

Un Manager la nivel de categorie are drepturi doar asupra categoriei alocate; pentru a gestiona mai
multe categorii, va trebui sa le atribuiti separat rolul respectiv in fiecare categorie.

Utilizatorii cu rol de Manager la nivel de categorie mai au dreptul de a administra orice subcategorie
din categoria respectiva, inclusiv posibilitatea de a cea noi subcategorii si de a muta cursurile din acea
subcategorie.

Acestia mai au permisiunea de a crea noi cursuri in categoria atribuita.

Course creator

Un utilizator cu rolul de Creator de curs are dreptul (dupa cum numele sugereaza) de a crea cursuri.
Daca setarea ,,Creators' role in new courses” din sectiunea Site administration > Users > Permissions >
User policies este lasata in modul implicit ,, Teacher”, atunci creatorul cursului este inscris ca profesor
in cursul pe care tocmai l-a creat si poate edita setarile cursului si inscrie alti utilizatori.

Un utilizator cu rolul de Course creator poate vedea de asemenea cursurile ascunse.

Daca unui utilizator i este atribuit un rol de Course creator la nivel de categorie de curs, butonul pentru
adaugarea unui nou curs este vizibil numai daca acea categorie contine cel putin un curs.

Utilizatorilor cu rol de Course Creator nu le este atribuit automat rolul de Teacher intr-un curs pe care
nu l-au creat, chiar daca respectivul curs se afla in categoria in care au fost atribuiti.

Atribuirea rolului

Unui utilizator i se poate atribui rolul de Course creator la nivel de sistem (in Site administration > Users
> Permissions > Assign system roles) sau la nivel de categorie.
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Teacher

Utilizatorii cu rol de Teacher au drepturi aproape depline intr-un curs, inclusiv addaugarea sau
modificarea activitatilor si notarea cursantilor. In mod implicit, profesorii pot atribui roluri de Non-
editing teacher sau Student, altor utilizatori.

Tn mod implicit, utilizatorilor nu i se atribuie rolul de Teacher la nivel de platform4, ci la cate un curs
pe rand. Aceeasi regula se aplica si cursantilor. Profesorii au posibilitatea de a preda doar la cursurile
in care au fost inrolati.

Atribuirea rolului de Teacher unui utilizator intr-un curs

Ca si Manager sau Site administrator, mergeti la pagina ,, Participants” din cadrul cursului
Selectati butonul ,,Enrol users”

Cautati utilizatorul dorit si selectati rolul Teacher

Selectati butonul ,,Enrol selected users and cohorts”

P wnNPR

Atribuirea rolului Teacher la nivel de categorie

Dupa cum este prezentat si mai sus, Tn mod implicit, utilizatorilor nu li se atribuie rolul de Teacher la
nivel de platforma. Totusi, in anumite conditii, este posibil sa doriti sa atribuiti unui utilizator sau grup
de utilizatori, rolul de Teacher la toate cursurile dintr-o categorie, sau la toate cursurile din platforma,
fard a fi nevoie de a inrola utilizatorul/utilizatorii, la fiecare curs pe rand. Astfel, puteti acorda aceasta
permisiune prin editarea rolului de Teacher (e mai recomandat, totusi, sa creati un nou rol pentru acest
lucru). Accesati Users > Permissions > Define roles > Selectati iconita de Edit din dreptul rolului de
Teacher > Context types where this role may be assigned. Daca selectati casuta pentru ,, Category”, fi
permite unui utilizator sd acceseze toate cursurile dintr-o categorie. Pentru a atribui un profesor unei
categorii, navigati la categoria respectiva, si folositi meniul Actions menu > Assign roles. Pentru ca rolul
de Teacher sa fie atribuit la toate categoriile trebuie sa navigati la fiecare categorie si sa repetati
operatiunea anterioara.

Daca doriti sa oferiti aceste drepturi unui grup restrans de profesori, puteti crea un nou rol de profesor
cu aceste permisiuni activate si sa le atribuiti doar acelor profesori la care doriti sa le atribuiti.

Non-editing teacher
Un utilizator cu rolul de Non-editing teacher are posibilitatea de a vizualiza si nota activitatea
cursantilor, dar nu au posibilitatea de a modifica sau sterge niciuna dintre activitati sau resurse.
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n cadrul cursurilor in care sunt utilizate grupuri de cursanti, utilizatorul cu rol de Non-editing teacher
poate fi responsabil pentru un anumit grup si nu va avea acces la alte grupuri. Pentru ca acest lucru sa
fie posibil modificati permisiunile acestui rol la nivel de platforma sau curs, astfel incat sa-i fie blocat
accesul la grupurile de care nu este responsabil. (Site administration > Users > Permissions > Define
roles > Selectati iconita de Edit din dreptul rolului de Non-editing teacher > Cdutati
moodle/site:accessallgroups in tabelul de permisiuni > Debifati Allow).

Student

Un utilizator cu rolul de Student in platforma, poate participa la activitatile unui curs si poate vizualiza
resursele acelui curs, dar nu le poate modifica si nu poate vedea catalogul clasei. Isi poate vedea
propriile note daca un profesor ii acorda aceasta permisiune.

Administratorii sau profesorii determina cum un cursant se inroleaza la un curs si ce pot acestia vedea
si face in platforma. Aceste permisiuni pot varia in functie de fiecare curs sau fiecare activitate. De
exemplu, intr-un context cursantii pot corecta si nota activitatea altor cursanti, pot fi incurajati sa
exploreze totul intr-un curs si s3 interactioneze cu alti participanti. intr-un context diferit, cursantul
poate fi ghidat pe o cale foarte bine definita, cu interactiuni minime cu ceilalti.

Guest

Vizitatorii se pot autentifica cu rolul de Guest folosind butonul ,Login as a guest”, de pe pagina de
autentificare, si pot accesa orice curs care permite accesul vizitatorilor. in plus, utilizatorii ce au conturi
create pe platforma, pot accesa in orice curs care permite accesul vizitatorilor fara a fi obligat sa se
inscrie la acel curs.

Vizitatorii au INTOTDEAUNA acces ,,read-only” - ceea ce inseamnd cd nu pot l3sa niciun mesaj.
Acestia nu pot:

e Posta pe forum-uri

e Edita pagini de tip wiki

e Participa intr-un chat

e Raspunde la teste sau chestionare

e Trimite lucrari

e Adauga comentarii sau date in activitati de tip Glossar sau Baza de date
e Primi note

Setari pentru accesul vizitatorilor
Pentru a permite utilizatori cu rolul de Guest pe platforma:

e 1n Site administration > Plugins > Enrolments > Manage enrol plugins, asigurati-va ci , Guest
access” este activat.

e In Site administration > Plugins > Authentication > Manage authentication, setati ,Guest login
button” cu ,Show”, daca doriti ca butonul sa apara pe pagina de autentificare.
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e Deasemenea actiunile vizitatorilor pe platforma pot fi inregistrate: Site administration > Plugins
> Logging > Log guest access.

Authenticated user

Atunci cand un utilizator se conecteaza pe platforma, i se atribuie automat rolul de Authenticated user.
Un utilizator va avea roluri suplimentare, pe langa cel de Authenticated user, in functie de locul in care
se afla in platforma, cum ar fi cursant la un curs.

Tn mod implicit, utilizatorii autentificati au permisiunea de a-si edita propriul profil, de a trimite mesaje,
de a scrie pe blog si de a face alte lucruri in afara cursurilor.

Atribuirea rolurilor

Context si roluri

n afara de rolul de manager si creator de cursuri, utilizatorii nu au in mod normal un rol la nivel de site
(sau sistem).

Chiar daca offline s-ar putea sa fii profesor, atunci cand te afli in platforma de e-Learning, ai putea avea
un rol de profesor in cursul Tn care predai si un rol de cursant intr-un alt curs unde studiezi pentru o
diploma.

Datorita modului de functionare a platformei, alocarea rolurilor se face pentru un anumit context. Un
site si un curs sunt exemple de doua contexte diferite.

Context la nivel de sistem

e Pentru a atribui un rol in context la nivel de sistem, accesati Site administration > Users >
Permissions > Assign system roles.

e Orice roluri atribuite aici se aplica pe intregul site. Prin urmare, are sens ca aici sa fie atribuite
doar roluri care au nevoie de aceasta functionalitate. Rolurile de manager si creator de curs
sunt exemple de doua astfel de roluri. Atribuirea unui rol de profesor sau cursant aici, ar duce
la posibilitatea de a preda / studia in fiecare curs de pe platforma, ceea ce nu este de obicei de
dorit.

Context la nivel Front page

e Front Page settings > Users > Permissions > Assigned roles

e Utilizatorilor care au un rol in context la nivel de sistem, nu mai trebuie sa li se atribuie un rol si
aici.

e Daca doriti sa oferiti unui profesor, drepturi de gestionare a articolelor de pe Front page, atunci
1i puteti atribui rolul in Front page.
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Context la nivel de categorie de curs

e Utilizatorii pot fi inrolati intr-o categorie pentru a salva inscrierea lor in fiecare curs individual
din acea categorie.

Context la nivel de curs

e Mergeti la pagina Participants

e Click pe butonul , Enrol users” si selectati utilizatorii pe care doriti sa-i inrolati.
e Selectati rolul pe care doriti sa-l atribuiti.

e Selectati,,Enrol selected users and cohorts”.

Context la nivel de bloc

e Actions menu (corespunzator blocului) > Permissions
e Puteti atribui roluri unui bloc daca, de exemplu, doriti ca anumite persoane sa vada blocul, in
timp ce acesta este ascuns pentru altii.

Context la nivel de activitate

e Accesati activitatea > Actions menu > Locally assigned roles

e Un exemplu in acest sens ar fi atribuirea unui cursant, rolul de profesor la nivel local intr-o
activitate individuala, precum un forum, astfel incat sa isi poata modera postarile colegilor de
curs, pastrand totusi rolul cursantului in restul cursului.

Context la nivel de utilizator

Contextul la nivel de utilizator este folosit pentru roluri precum cel de mentor, lider de echipa sau
parinte.

Rolul care trebuie atribuit trebuie sa aiba bifat ,,User” ca tip de context unde urmeaza sa fie atribuit.

Pentru a atribui unui utilizator rolul de mentor a unui alt utilizator, faceti click pe profilul utilizatorului
de care se ocupa, apoi pe , Preferences”, iar mai apoi pe ,/Assign roles relative to this user”.

Daca un mentor are o multime de utilizatori de care se ocupa, acesta le poate fi atribuit tuturor
deodata, dupa cum urmeaza:

1. Puneti toti utilizatorii ce vor avea mentor, intr-o cohorta
2. Mergeti la pagina ,Site administration > Users > Permissions > Assign user roles to cohort”

Ierarhia

Atribuind un rol unui utilizator intr-un anumit context, le acordati permisiunile continute in acest rol
pentru contextul actual si pentru toate contextele inferioare.

Lista contextelor in ordine ierarhica este urmatoarea:
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e System (fara parinte)

e Front page (parinte: System)

e Course category (parinte: Parent Category sau System)
e Course (parinte: Category sau System)

e Module (parinte: Course sau System)

e Block (parinte: Course sau System)

e User (parnte: System)

Rolurile pot fi mostenite. De exemplu, dacd unui utilizator i se atribuie un rol de profesor intr-o
categorie de curs specifica, utilizatorul va avea acest rol in TOATE cursurile din categorie.

Rolurile vor functiona numai daca atribuirea rolului se face in contextul corect. De exemplu: un rol de
profesor ar trebui sa fie atribuit unui utilizator Tn contextul categoriei de curs sau in contextul unui
singur curs, un rol de moderator de forum pentru un anumit forum ar trebui sa fie atribuit in acel forum
specific.

Atribuirea rolului de administrator al platformei
Pentru a atribui rolul de Site administrator accesati: Site administration > Users > Permissions > Site
administrators. Selectati numele din dreapta si mutati-l spre stanga.

Manage site administrators

Current site administrators o Add | Users
) Remowve )
Existing users (1} — ) Potential users (69) :‘
Mary Cooch (admin, INNIGEINGINGSE Donna Anforth (I
Jacgees Balmat |
Brigitte Bardot (I

Verificarea rolurilor atribuite unui utilizator
Pentru a verifica rolurile atribuite unui utilizator, accesati pagina profilului sau, apoi la rubrica
L»Administration”, faceti click pe , Preferences”.

n pagina ,Preferences”, la rubrica , Roles” faceti click pe ,, This user's role assignments”.

Roluri ascunse

Daca doriti sa le oferiti utilizatorilor acces la curs, dar nu doriti ca acestia sa fie vizibili in lista de
participanti, utilizati linkul ,,Other users” din meniul de administrare a cursului (,Actions meniu > More...
> Users > Other users”). Atribuirea de roluri in acest mod ofera acces la curs si drepturi de editare n
functie de permisiunile stabilite pentru rolul atribuit, fara ca acel utilizator sa fie inrolat de fapt la acel
curs.
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Atribuiri multiple

O parte semnificativa a infrastructurii de roluri este posibilitatea de a atribui unui utilizator mai multe
roluri (Tn acelasi timp). Permisiunile fiecarui rol sunt contopite pentru a produce un set de permisiuni.
De exemplu, un utilizator ar putea avea rol atat profesor, cat si de cursant in acelasi curs.

Asigurati-va in cazul in care schimbati rolul unui utilizator, ca 1l indepartati de orice alte roluri, dupa
cum este necesar.

Adaugare curs

Tn mod implicit un utilizator cu rolul de Teacher nu poate adduga un curs. Pentru a adduga un curs pe
platforma, utilizatorul trebuie sa aiba rolul de Site Administrator, Manager sau Course creator.

Pentru a adauga un curs nou:
e Din Site administration > Courses > Manage courses and categories

Course and category management

Course categories Miscellaneous

New cowrse | Re

« Miscetaneous

Re-sort sub categories of selected categories

v

Move selected categories to

~

e Selectati categoria in care doriti sa fie cursul
e Selectati butonul ,New course”
e Introduceti setarile cursului si apoi selectati ,Save and return” sau ,,Save and display”

Stergerea unui curs

Utilizatorii cu rol de Teacher nu pot sterge cursurile din platforma. Pot cei cu rolul de Site administrator
sau Manager. Utilizatorii cu rol de Course creator pot sterge doar cursurile create de ei, dar numai in
termen de 24 de ore de la crearea cursului.

Pentru a sterge un curs:

e Din Site administration > Courses > Manage courses and categories
e Faceti click pe categoria cursului si identificati cursul dorit in coloana din dreapta.
e Selectati iconita pentru ,Delete”.
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Categorii de cursuri

Categoriile de cursuri sunt folosite pentru a organiza cursurile pentru toti utilizatorii din platforma de
e-Learning. Categoria de curs implicita pe o noua platforma de e-Learning este ,Miscellaneous” (desi
aceasta poate fi redenumita). Cursurile pot fi puse toate in aceasta categorie. Totusi, utilizatorilor le va
fi mai usor sa-si gaseasca cursurile daca sunt organizate in categorii descriptive.

Tn mod implicit, lista cursurilor dintr-o categorie aratd profesorii si rezumatul fiecdrui curs. Daca
numarul de cursuri dintr-o categorie depaseste 9, atunci se afiseaza o lista scurta fara profesori si
rezumat.

Adaugarea unei categorii
e Mergeti la Site administration > Courses > Add a category
e Completati setarile dorite si selectati ,Create category”

Alternativ, puteti merge la Site administration > Courses > Manage courses and categories si sa selectati
butonul ,,Create new category”.

Editarea unei categorii
Puteti edita setarile unei categorii din Site administration > Courses > Manage courses and categories
si selectarea iconitei pentru , Edit”.

Adaugarea unei subcategorii
Site administration > Courses > Manage courses and categories

Puteti transforma o categorie intr-o subcategorie a alteia bifand caseta din stanga numelui acesteia,
apoi selectand din meniul drop-down ,Move selected categories to”.

Puteti crea o subcategorie noua, facand click pe iconita ,, Actions menu” din dreapta categoriei in care
doriti sa o adaugati si selectand , Create new subcategory”.

Ascunderea categoriilor

Categoriile pot fi usor ascunse sau afisate prin intermediul ,Site administration > Courses > Manage
courses and categories” si selectarea iconitei in forma de ochi, din dreptul categoriei pe care doriti sa
o ascundeti.

Categoriile ascunse sunt vizibile numai administratorilor site-ului sau celor care au permisiunea ,,View
hidden courses”.
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Setarile unui curs

Sectiunea General
Course full name

Acesta este titlul cursului. Este afisat ca un link pe listele de cursuri, pe Front page, pe Dashboard si in
rapoarte.

Short name

Acesta va fi utilizat Tn mai multe locuri in care ,, Course full name” este prea lung, cum ar fi blocul de
navigare.

Course category

Course start date

Aceasta setare afecteaza afisarea jurnalelor de activitate si datele din subiectul formatului saptamanal.
Daca utilizati formatul de curs ,,Weekly”, data de inceput va aparea in prima sectiune a cursului.
Course end date

Data de finalizare a cursului este utilizata pentru a determina daca un curs ar trebui inclus in lista de
cursuri a unui utilizator.

Dupa data de finalizare, cursul nu mai este listat in blocul de navigare si este listat ca finalizat in lista
cursurilor cursantului.

Utilizatorii mai pot intra in curs dupa data de finalizare; cu alte cuvinte data nu restrictioneaza accesul.

Calculate the end date from the number of sections

Doar pentru cursuri in format saptamanal, data de finalizare a cursului poate fi calculatd automat pe
baza datei de incepere a cursului si a numarului de sectiuni. Daca sectiunile de curs (saptamani) sunt
adaugate sau eliminate, data cursului este modificata automat.

Course visibility

Cu aceasta setare va puteti ascunde complet cursul. Acesta nu va aparea in lista de cursuri a
utilizatorilor, cu exceptia celor cu rol de Manager, Course creators, Teachers si oricarui alt utilizator
care are capacitatea de a vedea cursurile ascunse. Chiar daca utilizatorii Tncearca sa acceseze direct

Pagez 0
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Sectiunea Description

~ Description

Course summary (3

Add a desaiption of
your course here

Course summary files )

Add an image for your course here i
(The admin must enable
other fils hypes)

PRI crag anc arop files Mere 10 393 them

Sectiunea Course format
Hidden sections

Aceasta optiune va permite sa decideti modul in care sectiunile ascunse din curs sunt afisate
cursantilor. Tn mod implicit, este afisatd o zond micd pentru a indica unde se afl§ sectiunea ascunsa,
desi utilizatorii Tnca nu pot vedea activitatile si textele ascunse.

Course layout

Setarea cursului stabileste daca intregul curs este afisat pe o pagina sau impartit pe mai multe pagini.

Sectiunea Appearance
Show gradebook to students

Aici puteti decide daca permiteti cursantilor sa vada linkul catre note. Daca cursul nu utilizeaza activitati
notate, este logic sa dezactivati acest lucru.

Sectiunea Completion tracking
Urmarirea finalizarii trebuie sa fie activata pentru a putea folosi , Activity completion”.

Criteriile de finalizare a cursului pot fi, de asemenea, bazate pe criteriile de finalizare a activitatilor.
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Sectiunea Groups

Groups

Group mode Mo groups v

Force group mode No |w

Default grouping | pone | w

Group mode

Aici puteti defini modul de grup la nivelul cursului printr-un meniu drop-down. Setarea selectata va fi
modul de grup implicit pentru toate activitatile definite in cadrul cursului respectiv. Setarea modului
de grup poate afecta ceea ce utilizatorii vad in lista de participanti si cu cine pot interactiona in
activitati.

e No group - Nu exista grupuri, toata lumea face parte dintr-o comunitate mare

e Separate groups - Fiecare grup isi poate vedea propriul grup, utilizatorii din alte grupuri sunt
invizibili.

e Visible groups - Fiecare grup lucreaza in propriul grup, dar poate vedea si alte grupuri.

Force

Daca modul de grup este ,,fortat” la un nivel de curs, atunci modul de grup selectat va fi aplicat fiecarei
activitati din acel curs.

Acest lucru va inlocui orice setare a unei activitati care poate avea o setare speciala de grup.

Formatul de curs

Un format de curs se refera la aspectul unui curs.

Weekly format
Cursul este organizat saptamana, dupa saptamana, fiecare sectiune avand o titlul cu data specifica.
Platforma va crea o sectiune pentru fiecare sdaptamana a cursului.

Sfat: Dacd doriti ca toti cursantii sd lucreze la aceleasi materiale, in acelasi timp, acesta ar fi un format
potrivit.

Topics format
Cursul este organizat in sectiuni tematice carora un profesor le poate da titluri.

Social format
Acest format este orientat in jurul unui forum principal, forumul social, care apare listat pe pagina
principala.
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& Restore by Anna Alexander - Wednesday, 6 August 2014, 539 PM . Jmm ;T:’);IOI Gartto
& s ’
‘; mport As pant of the New Teacher Induction process, Scott and | will be running a session period « your locl homeschooling

L. e PR R wanioh % - P

Cand selectati formatul social, este posibil sa specificati cate discutii doriti sa afisati pe pagina de curs:
Format (¥) | Social format v

Number of discussions (2} 10

Activitati si resurse pot fi adaugate pe o parte utilizand blocul ,Social activities”.

Single activity format

Formatul ,Single activity” are doar o sectiune si permite profesorului sa adauge doar o activitate la
curs. Cand este selectat formatul ,Single activity”, apare un meniu drop-down din care profesorul
poate sa aleaga activitatea pe care doreste sa o utilizeze.

Course format

Format &5 Sege activty Sormel v

Typeotactvry &  Forum
Assgnmem

» Appearance ook

ohat
» Files and uploads it
Oalabace
» Completion tracking ”::: :‘"
e

» Groups

¥ obeat

» Role renaming Gossary
M5 CONMtIt DACKAGE
Lesson

Dage
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Pagina principala a unui curs

Boost example . i
Example course with Boost theme »
Participa . 4 . [ e £ Eon setrngs ‘1*
Badges ,' Turn editing on
Competenoes ¥ Fiters ‘
Grade @ £ Gradebook setup
- & Outcomes
B Genera A
= o & Backup
- "
'_f_,i‘a', ?
17 December - 23 December =
0a bR
@ Publsh
B 31 December- 6 January 24 December - 30 December 2 Resat
13} y & Mor
31 December - 6 January
hbo
et 7 January - 13 January
Cale
[ )
My ¢ -
ants 1 Cit
10 iy T

3 — Sectiunea cursului — sectiunea unde activitatile si resursele sunt afisate
5 — Blocul de Navigare

6 — Actions Meniu

Pentru a edita sectiunea unui curs
e Activati editarea din meniul Actions Menu > Turn editing on
e Faceti click pe iconita creion (1 in imaginea de mai jos) pentru a redenumi rapid sectiunea
e Faceti click pe meniul ,,Edit” (2 in imaginea de mai jos) pentru a edita descrierea si alte setari.
Welcome ~

4 @ Edit~

| Edit top;c name Edit section
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Pentru a adauga noi sectiuni de curs
e Activati editarea din meniul Actions Menu > Turn editing on
e Dati clic pe ,Add topics/weeks” in sectiunea de jos
e Selectati numarul de sectiuni suplimentare pe care doriti si selectati ,Add topics/weeks”

Add topics

Murmber of sections |3 -

Cancel

Pentru a sterge sectiunile cursului

Cu editarea activata, faceti click pe linkul ,,Edit” din dreapta sectiunii de curs pe care doriti sa o stergeti,
apoi, din meniul care se afiseaza, faceti clic pe , Delete”. Retineti ca toate activitatile din sectiune
respectiva si datele utilizatorilor lor vor fi, de asemenea, sterse. Folositi ,,Recycle bin” pentru a restabili
sectiunea stearsa daca v-ati razgandit.

Blocuri
Pentru a adauga un bloc la pagina cursului:

e Activati editarea din meniul Actions Menu > Turn editing on
e Selectati un bloc din meniul ,Add block”

Activitati si resurse
Pentru a adauga o activitate sau resursa la curs:

e Activati editarea din meniul Actions Menu > Turn editing on

TR ]

e Selectati o activitate sau resursa, apoi faceti click pe butonul ,Add” sau pur si simplu faceti dublu
click pe numele activitatii sau resursei.

Acces restrictionat

Functia de acces restrictionat permite profesorilor sa restrictioneze disponibilitatea oricarei activitati
sau chiar a unei sectiuni de curs in functie de anumite conditii, cum ar fi data, nota obtinuta, finalizarea
unei activitatii.
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Week 4: Taking it Further (28 Jan - 3 Feb)

Not available unless:
+ The activity Tell us how we may use your data is marked complete (hidden otherwise)
« The activity Choose how to progress through the course is marked complete (hidden otherwise)
» Any of (hidden otherwise):
o ltis after 28 January 2019, 12:05 AM
o You bhelong to All at once
» Itis after 7 January 2019, 12:05 AM (hidden otherwise)

Tn pagina setdrilor fiecdrei activititi existd o sectiune pentru setdrile accesului restrictionat: , Restrict
access”.

Tn aceasts sectiune selectati butonul ,, Add restriction” si vi se va deschide un meniu de optiuni.

Add restriction...

Date Prevent access until (or
from) a specified date and
time.

Grade Require students to

achieve a specified grade.

Allow only students who
belong to a specified
group, or all groups.

Group

Allow only students who
belong to a group within a
specified grouping.

Grouping

Control access based on
fields within the student's
profile.

User profile

Restriction set Add a set of nested
restrictions to apply
complex logic.

Cancel

Restrictia poate fi bazata pe finalizarea unei alte activitati, data, nota, grupul sau gruparea elevilor sau
chiar pe campurile profilului utilizatorului.

Pagez 6

Telefon: +40 0262 226 778 » Fax: +40 0262 226 778
WEB: http://www.holisun.com e E-mail: info@holisun.com



we bring you the future HOL'SU N \3
I - -
www.holisun.com

Butonul ,Restriction set” permite, de asemenea, criterii mai complexe care necesita mai multe conditii
de concatenat.

Data

Accesul poate fi restrictionat de la / pana la o anumita data si ora.

Date 12 ¢4 August & 2019 4 00 % ° 00 %

unil

Add restriction...

Nota

Puteti specifica o conditie pentru orice nota a cursului: nota totala a cursului sau o nota de la orice alta
activitate. Puteti introduce fie o valoare minima (cel putin procentual), o valoare maxima (mai mica
decat procentul), ambele, sau niciuna dintre ele. Activitatea va putea fi accesata numai daca cursantul
are o valoare pentru nota specificata si daca se incadreaza in orice interval de valori specificate. Puteti
adauga mai multe conditii de nota. In acest caz trebuie indeplinite toate conditiile pentru ca activitatea
sa apara.

Grupuri sau grupari
Daca n curs sunt utilizate grupuri sau grupari de cursanti, este posibil sa restrictionati activitatea la un
anumit grup.

Group + Choose... II..""."'.!:.'.I
{Any group)
Group A

Add restrictit Group B

Ascunderea conditiilor
Daca iconita sub forma de ochi este debifata, atunci cursantii care nu indeplinesc acea parte a conditiei
nu vor vedea activitatea deloc.

Daca iconita sub forma de ochi este bifata, atunci cursantii care nu indeplinesc acea parte a conditiei
vor vedea activitatea, dar aceasta va fi marcata ca inactiva si vor avea informatii despre motivul pentru
care nu o pot accesa inca.
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Access restrictions Student must ¥ match the following

Click to hide @ Datel| from 26 r Apr” v 2014 oo+ - 00 v X

COMPLETELY

Add restriction...

Toate sau una dintre conditii
Pot fi addugate alte restrictii facand click din nou pe butonul ,Add restriction” si este posibil sa
specificati fie ca TOATE conditiile, fie ca UNA dintre conditii, sunt necesare inainte ca activitatea sa fie

disponibila.

b Shadenl st W III_1'_'EI,| the Tollorarg

& [Dals from * T . ¥ M4 v o MW

(=

® Liger profile field  Departrnert * | i squal i * | Languages ™

=]

@ Orade  OfMine AsSigrrmen; T # musbez 80 o musl be - % X

Add resticton

Add restnchoe

Restrictionarea accesului la o sectiune a cursului

Este posibil sa restrictionati accesul la activitatile si resursele dintr-o sectiune a cursului, specificand
conditiile de acces n setarile pentru acea anumita sectiune. Accesati Edit > Edit week / topic > Restrict
access.
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Summary of Topic 1
v Collapse all
~ General
Section name Custom

Tepic1

Summary 7]

-
>
4
=
—
iii
i
&*
(:)
¥
&
-
=

~ Restrict access

Access restrictions

None

Acd restriction,.,

Save changes Cancel

Activitati ascunse / ,orfane”

Aceste tipuri de activitati nu sunt vizibile pe pagina cursului dar pot fi utilizate de catre cursanti.

Activarea functionalitatii

Din Site administration > Advanced features, administratorii pot activa , Allow stealth activities” in
cursuri.

Utilizare functionalitate

1. Activati editarea din meniul Actions Menu > Turn editing on
2. Din meniul Edit din dreptul activitatii / resursei selectati ,, Hide”
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+ Quizzes ¢ .
"I"E Revision quiz list #* Edit = 7
"I"\xr,f- Quiz1 & Fditv & 4
P Quiz2 ¢ Edit~ & &
Py Quiz3 & Editv &
Py Quiza & Edit~ & [

3. Din acelasi meniu ,,Edit” selectati ,,Make available”

& Quizzes ¢ Edit +
+ E Revision quiz list #* Edit ~ %
‘{"@ Quiz1 & Edit~ & 4
‘I"@ Quiz2 & Edit~ & 4
‘*’\/ Quiz3 & Editv & [
"I"l Quiz4 & Edit~ & %

R
Hidden from students & edit settings
9 Move right dr resource
4 Discussion forums ¢ LT Edit +
Mak ilabl
‘{"% Ask questions about the exam here ¢ © Make available
‘{"% Problems? Your co-participants are here (@ Duplicate @

4. Nu uitati sa distribuiti link-urile catre aceste activitati, pentru ca sa poata fi accesate de cursanti.
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Inscriere la curs

Inscriere manuala

Verificati daca aveti inscriere manuala activa la curs

intr-un curs mergeti la pagina ,Participants” si din meniul ,Actions Meniu” selectati ,Enrolment
methods”. Tn pagina deschisd asigurati-vd ca ,Manual enrolments” are iconita sub formd de ochi
activata.

Enrolment methods

Hame Users Up/Dowmn Edit
Manual enrolments 2 + XX = ) O
0 T * X w
0 4 X & o

Add method

Choose v

Modificarea setarilor inscrierii manuale la curs

Un administrator sau un manager pot edita setdrile metodei de inscriere manuala in curs, si sa seteze
perioada implicita de inscriere si rolul implicit daca acceseaza link-ul paginii ,,Edit” din dreptul metodei
de inscriere din sectiunea ,,Manual enrolments”.

“Manual enrolments

Enable manual |yes E]
enroiments (2)

Default role | Sudent -
Default enrolment o days Enable
duration (2)
Notify before | No E]

enrolment expires (2) | Enroller only
Enroller and enrolled user

Notification thresngld 1 days |
) weeks
hours
| minutes

Save cha seconds |

Este posibil, de asemenea, ca elevii si / sau profesorii sa fie notificati atunci cand le expira inrolarea la
curs, selectand ,,Enroller only” sau ,Enroller and enrolled user” din meniul drop-down ,Notify before
enrolment expires” si o limita de timp in ,Notification threshold”.
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Inscrierea cursantilor

1.
2.
3.
4

5.
6.

Accesati pagina ,Participants” din cadrul cursului

Selectati butonul ,,Enrol users”

Folositi meniul drop-down ,Assign roles”, daca doriti sa schimbati rolul pe care il atribuiti
Selectati ,Show more” daca doriti sa extindeti optiunile implicite de inscriere. Aici puteti
modifica durata inscrierii

Cautati utilizatorii si selectatii

La final selectati butonul ,,Enrol selected users and cohorts”

Setarea perioadei de inscriere pentru fiecare cursant

1.
2.
3.

Accesati pagina ,Participants”
Selectati iconita pentru ,Edit” din dreptul unui utilizator
Editati datele dupa cum e necesar si salvati modificarile , Save changes”

Auto-inscrierea

Auto-inscrierea este metoda prin care utilizatorii pot alege sa se inscrie intr-un curs, fie imediat facand

click pe ,,Enrol me in this course”, fie tastand o cheie de inscriere carora li s-a oferit. Plugin-ul de auto-

inscriere trebuie sa fie activat de administratorul site-ului in Site administration > Plugins > Enrolments

> Manage enrol plugins si mai trebuie sa fie adaugat si activat in cadrul cursului in care se doreste

utilizarea lui: ,Partipants” din cadrul cursului respectiv > Actions Meniu > Enrolment methods.

Participants B -

No filters applied &+ Enrolled users

eyword or selecy Enrolment methods@

Manual enrolments

First name All A B FIG H ] KILMNOPQR S
Surname IN\M -~ B C D E F G H JIKILIM|[N/O/P QR[5 Guest access
First name « / Last a
Select Surname Email address Roles Groups courst & Groups
Permissions
- Student No
Sam Student student@moodle.a 4 year
& groups @ Check permissions
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Enrolment methods

MName Users Up/Down Edit
Manual enrolments 2 L o ®a+ &
Guest access 0 LR 4 iR
Self enrolment (Student) 0 > i & &

U

Add method | Choose...

Adaugarea unei chei de inscriere la un curs

Daca doriti ca doar un anumit grup de utilizatori sa se auto-inscrie (si nu oricine), atunci puteti seta o

cheie de inscriere pe care apoi le-o transmiteti sa o foloseasca atunci cand acceseaza ecranul de auto-
inscriere.

~ Self enrolment (Student)
Enroiment key

Unmask

You should have received this enroiment key from

O
* Norman Bates

Setarea unei chei de inscriere

1. , Partipants” din cadrul cursului respectiv > Actions Meniu > Enrolment methods
2. Selectati meniul ,,Edit” din dreptul metodei de auto-inscriere

Marmm Usais Up'Diawn Edit
PAIRI ETTONTRENS. 2 - O

3. Adaugati cheia de inscriere in caseta furnizata.
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Custom instancs name

Enable existing enrolments

Allow new enrolments Yeg T
Enrcimsnt key Jnmask
Use group enrolment keys H *

4. Salvati modificarile.

Adaugarea unei chei la nivel de grup pentru inscrierea la un curs
Daca doriti ca utilizatorii sa se inscrie direct intr-un grup de curs, puteti seta o cheie de inscriere la nivel
de grup pe care apoi sa le-o transmiteti sa o foloseasca atunci cand acceseaza ecranul de auto-inscriere.

Setarea unei chei de inscriere la nivel de grup

1. Urmati pasii prezentati mai sus pentru adaugarea unei chei de inscriere la curs
e Daca nu setati o cheie principala de inscriere pentru curs, atunci oricine se poate inscrie
fara cheie, iar utilizatorii nu vor fi pusi in grupuri.
e Utilizatorii din grupuri nu trebuie sa cunoasca cheia principala de inscriere la curs, doar
cheia de inscriere de la grup.
e Utilizatorii care nu fac parte dintr-un grup pot utiliza cheia principala de inscriere la curs
2. Modificati setarea ,,Use group enrolment keys” in ,Yes”.
3. Salvati modificarile, iar apoi in accesati butonul ,,Actions Menu” din pagina principald a cursului
> More... > Users > Groups > Create group
4. Adaugati o cheie de inscriere la nivel de grup. Aceasta va fi cheia utilizata pentru inscriere la
curs.

*Urmatoarele setdri prezentate mai jos vor putea fi modificate prin accesarea link-ului ,Edit” din
dreptul metodei de auto-inscriere din pagina Participants > Actions Menu > Enrolment methods.

Durata inscrierii
La fel ca si la metoda de inscriere manuala.

Anularea inscrierii cursantilor ce nu au fost activi la curs
Alegeti numarul de zile din meniul drop-down "Unenrol inactive after"

Setarea unui numar maxim de cursanti la un curs
Introduceti numarul maxim de cursanti pe care i doriti la cursul in ,,Max enrolled users”.
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Acceptarea auto-inscrierii doar cursantilor ce fac parte dintr-o

cohorta
Daca aveti cohorte configurate la nivel de platforma, atunci puteti activa auto-inscrierea doar pentru
anumite cohorte, selectand numele cohortei din meniul drop-down ,,Only cohort members”.

e Enrolment options

Max enrglled users |0

Only cohaort rnerrtue;rs Prysics Faculty Z|
@
Send course welcome ¥

message

Oty members of cahont "Physics Faculty' can self-enrol

Trimiterea unui mesaj de bun venit noilor utilizatori
Utilizatorii pot primii urmatorul mesaj prin e-mail atunci cand se auto-inscriu la un curs:

,Welcome to {Course name}

If you have not done so already, you should edit your profile page so that we can learn
more about you: {link to profile page}”

Puteti seta sd trimiteti un mesaj custom. In mesaj pot fi incluse urmétoarele variabile:

e Course name {Sa->coursename}

e Link to user's profile page {Sa->profileurl}
e User email {Sa->email}

e User fullname {Sa->fullname}

Cohort sync

Cohort sync este pentru inscrierea automata a membrilor unei cohorte intr-un curs. Daca un utilizator
este adaugat sau eliminat din acea cohortd, atunci acesta este automat inscris sau, respectiv, ii este
anulata nscrierea automat. Cu alte cuvinte, Cohort sync sincronizeaza apartenenta la o cohorta cu
inscrierea la un curs.

Pentru a putea fi utilizata, trebuie sa fie activata de catre un administrator in Site administration >
Plugins > Enrolments > Manage enrol plugins.

Inrolarea unei cohorte la un curs
Nota: Pentru ca optiunea ,,Cohort sync” sa fie accesibild, trebuie ca cel putin o Cohortd sd existe si sd
fie disponibild fie la nivelul site-ului, fie la nivelul categoriei in care se afld cursul.

1. Accesati,Partipants” din cadrul cursului respectiv > Actions Meniu > Enrolment methods
2. Selectati, Cohort sync” in mediul drop-down ,,Add method”
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3. Selectati cohorta dorita si faceti click pe butonul ,,Add method”

Enrolment methods

Name

Manual enrolments

Self enrolment (Student)

Add method

Cohort sync v

Self enrolment
Cohort sync
Course meta link

Tn mod implicit, profesorii pot ad3uga cohorte la cursuri, dar un manager sau un administrator poate
ascunde anumite cohorte de profesori, debifand optiunea ,,Visible” din setarile cohortei sau facand
click pe iconita in forma de ochi din lista de cohorte.

~ Cohort sync
Custom instance name

Active Yes v

Cohort* Choose.. v
Assign role Student v
Add to group None v

Add method Add method and create another Cancel

Cand se sincronizeaza o cohorta la un curs, este posibil sa se adauge automat toti membrii cohortei
intr-un grup. Un nou grup poate fi, de asemenea, creat atunci cand se adauga cohorta.

Add to group None v

MNone

Create new,group
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Accesul vizitatorilor

Functionalitatea de acces ,,Guest” permite utilizatorilor cu rolul de Guest sa vizualizeze continutul unui
curs.

1. Accesati,Partipants” din cadrul cursului respectiv > Actions Meniu > Enrolment methods

2. Activati metoda ,,Guest access” facand click pe iconita in forma de ochi din dreptul metodei,
sau adaugati-o din meniul drop-down ,,Add method” daca nu o gasiti in lista

3. Puteti seta o parola de acces in pagina setarilor metodei. Accesati link-ul , Edit” din dreptul
metodei.

Nota: Vizitatorii nu pot accesa activitdtile cursului.

Inscrierea in categorie

Plugin-ul de inscriere la categorie permite utilizatorilor sa fie inscrisi la toate cursurile dintr-o categorie.

Pentru a putea utiliza metoda de inscriere la categorie, e nevoie ca un administrator sa activeze pulgin-
ul ,,Category enrolments” in Site administration > Plugins > Enrolments > Manage enrol plugins.

Atentie! Utilizarea plugin-ului pentru inscriere la categorie poate cauza probleme de performantd. Este
recomandat sa utilizati in schimb, Cohort sync, desi acest lucru va necesita ca o metodd de Cohort sync
fi addugata la fiecare curs din categorie.

1. Accesati categoria in care doriti sa faceti inscrierea utilizatorilor. (trebuie sa aveti permisiuni de
editare la nivel de categorie: de obicei un administrator sau manager)
2. Selectati meniul Actions Meniu > Assign roles

Assign roles in Category: Media

Please choose a role to assign

Category. Media o )
Role Description Usars with role

0

o+ ASsign roles
b r

3. Va aparea lista de roluri posibile pe care le puteti atribui. Rolurile pe care le vedeti aici sunt
roluri care au fost alocate Tn contextul categoriei si pe care puteti sa le atribuiti, adica rolului i-
a fost bifat de catre un administrator, in Site administration > Users > Permisssion > Define roles
> Selecteazd rol > Edit, la campul ,Context types where this role may be assigned” contextul
,Category”.
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4. Ca sa va asigurati ca noii utilizatori vor fi inscrisi automat ca si cursanti / profesori in toate
cursurile noi create din acea categorie, un administrator trebuie sa seteze permisiunea
corespunzatoare pentru rolul in cauza in sectiunea Site administration > Users > Permisssion >
Define roles > Selecteazad rol > Edit

Context types
where this role may be

assigned

/ ¥ Course

#  Activity module
Block

System

Capability Permission (T)

Category enrolments

Role assignments synchronised o course enrolment EI

enralicategary synchronised Molget  Allow  Prevenl  Prohibit

Resurse

O resursa este un element pe care un profesor il poate utiliza pentru suport de curs, cum ar fi un fisier
sau un link.

Cu optiunea , Turn editing on”, din meniul ,,Actions Meniu”, activata, un profesor poate adauga resurse
prin selectarea butonului ,,Add an activity or resource”.

Common module settings

Tn pagina de setdri pentru multe resurse si activititi, existd o sectiune numitd "Common module
settings".

Availability
Setarea ,Availability” are pana la trei optiuni posibile (depinde daca , Allow stealth activities” este
activata de un administrator in ,Site administrator”).

»Show on course page”

Activitatea sau resursa este disponibila tuturor studentilor (sub rezerva oricaror restrictii de acces care
pot fi setate).

»Hide from students”

Activitatea sau resursa este disponibila numai utilizatorilor cu permisiunea de a vizualiza activitati
ascunse. (implicit, utilizatorii cu rol de Taecher sau de Non-editing teacher).

»Make available but not shown on course page”
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Pentru simplificarea paginii de curs. Un link catre activitate sau resursa trebuie furnizat din alta parte,
cum ar fi de la o alta resursa a paginii.

Group mode
Grupurile sunt setate la nivelul cursului.

Atunci cand in setarile cursului, cdmpurile ,,Group mode” este activat si cdmpul ,,Force group mode”
este setata cu ,No”, campul ,,Group mode” din cadrul activitatii poate fi:

»No groups”
Nu exista grupuri si toti cursantii 1si trimit lucrarile lor individuale Tntr-o singura zona.
,Separate groups”

Cursantii Tsi trimit lucrarile, iar profesorii pot sorta aceste lucrari dupa grup sau pot vedea toti
participantii.

»Visible groups”

Toti cursantii isi trimit lucrarea intr-o singura zona, dar pot alege cu ce grup sa asocieze trimiterea lor
inainte de incarcare.

Book

Resursa ,,Book” simplifica crearea de resurse cu mai multe pagini cu un format asemanator unei carti.

Ng Cepartments N terms of use of ICT Web 2 (

0 3rvral
A and USe OUr eupertise 10 AsSE! other leaming aneas by
h ihe atest developments onine

SUse ot ICT

Qrevar PosSiDio 10

€5 YORrAcIVe Wi A vanaty of meaia

rafrer than plan leat) 10 highiight and enhance the use of technology i leaming
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Resursa ,Book” va permite sa aveti capitole principale si subcapitole. Resursa ,Book” nu este
interactiva. Cu toate acestea, puteti face din ,,Book” link-uri catre diverse alte activitati din curs, de
exemplu teste, forumuri etc. De asemenea, pot fi incluse materiale multimedia.

Setari resursa Book
n sectiunea General se adaugi setdri precum numele resursei, descrierea, etc.

Se pot activa setdri pentru acces restrictionat in ,Restrict access” si setari pentru completarea activitatii
in , Activity completion”.

Appearance
Appearance
Chapter formatting MNumbers |+
Custom fitles U
Chapter formatting

e None —titlurile capitolului si subcapitolului nu sunt deloc formatate, utilizati aceasta setare daca
doriti sa definiti stiluri de numerotare speciale.

e Numbers — capitolele si subcapitolele sunt numerotate (1, 1.1, 1.2, 2, ...)

e Bullets — subcapitolele sunt aliniate la dreapta si afisate cu buline

e Indented — subcapitolele sunt alinate la dreapta

Style of navigation

Alegeti intre navigare prin imagini (1) sau prin link-uri text (2) sau fara navigare, doar , Table of

contents” (3).

Book - Departmental Policies

2 Homework

“* (1) = Imagini
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Book - Departmental Policies

--------

2 Homework

wewes (2) = Link text

Book - Departmental Policies

2 Homework

(3) — doar Table of contents
Custom titles

Daca nu activati ,Custom titles”, titlul capitolului (cel care apare in ,Table of contents”) va aparea ca
antet Tn partea de sus a continutului (1 de mai jos). Daca activati , Custom titles”, veti putea crea un
titlu diferit de cel care apare in ,Table of contents” sau nu va afisa niciun titlu (2 de mai jos). Daca
activati ,,Custom titles”, va trebui sa introduceti titlul capitolului ca parte a continutului paginii.

Table of contents E]

Leasning with Phonics Leaming with Phonics

Navigation °1 Phonics 15

Table of contents B

Learming with Phonics custom ”
How to start i L

Navigation

Adaugarea de capitole si subcapitole
Titlurile capitolelor apar ca link-uri in ,, Table of contents” din dreapta continutului. Este recomandat sa
mentineti titlurile scurte.

Pentru a adauga un capitol:

1. Accesatiresursa ,,Book”. Selectati Actions Meniu > Turn editing on sau butonul din dreapta sus
cu acelasi nume

2. Selectati iconita ,,+” in ,, Table of contents”, din dreptul capitolului dupa care vreti sa adaugati
noul capitol.

Telefon: +40 0262 226 778 » Fax: +40 0262 226 778
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Table of contents

Learning with Phonics 2] w
3

[ Add new chapter }

Puteti adduga subcapitole Tn acelasi mod. O subcategorie nu mai poate avea alte subcategorii.

Chapter tile” |Have a pencil to hand
Smxhapte
Content” ' contfamby = Fontsze = Paragraph
BZIUwmex, x EESE J L4
== = 3 I - RUTRY)

I's often useful if you are reading non ficion to |

Platforma ofera o posibilitate usoara pentru un profesor de a-si prezenta materiale de curs, cursantilor,

cum ar fi documente Word, pdf-uri sau prezentdri de PowerPoint. Toate tipurile de fisiere pot fi

incarcate si accesate prin platforma, dar cursantul trebuie sa aiba software-ul corect pentru a le putea
deschide.

Fisierele pot fi adaugate prin incarcarea de pe o sursa externa, cum ar fi un computer sau o unitate

USB, sau prin drag-and-drop, direct pe pagina cursului. Ambele optiuni necesita activarea editarii in
Actions Menu > Turn editing on.

Nota: modul in care cursantii vor vedea fisierul va depinde de tipul de fisier si de setdrile sale de afisare.
Ca de exemplu, o prezentare PowerPoint incdrcatd nu va fi redatd asa cum s-ar intdmpla pe un
»Whiteboard” chiar dacad este salvatd ca ,,Show”. Cursantii vor fi solicitati sG o descarce.

Course materials

Setari resursa File

n sectiunea General se adauga setdri precum numele resursei, descrierea, precum si fisierul ce va fi
incarcat in platforma.

Page4 2
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Se pot activa setdri pentru acces restrictionat in ,Restrict access” si setari pentru completarea activitatii
in , Activity completion”.

Display

»Automatic”

Platforma va alege cea mai potrivitd metoda de afisare.

,Force download”

Utilizatorul selecteaza fisierul, care va fi descarcat in computerul acestuia.

»Embed”

Platforma va deschide fisierul intr-o pagina separata, heading-ul si footer-ul platformei vor fi afisate pe
acea pagind, Impreuna cu blocurile platformei, titlul si descrierea resursei tip fisier. (potrivit pentru
fisierele video, pdf-uri, imagini)

»Open”

Asemanator cu optiunea ,,Embed”, doar ca in cazul acesta fisierul va fi deschis intr-o pagina de browser
simpl3, fara, heading, footer, blocuri sau descriere.

»In pop-up”

Asemanator cu optiunea ,,Open”, doar ca fisierul va fi deschis intr-o fereastra noud, mica de browser,
separata.

,New window”

Asemanator cu optiunea ,,/n pop-ip”, doar ca fereastra nou deschisa se va deschide intr-un nou tab al
browser-ului.

Folder

O resursa de tip folder permite unui profesor sa afiseze impreuna mai multe fisiere de curs. Fisierele
pot fi de diferite tipuri si pot fi incarcate dintr-o singura data, sub forma unui arhive care este apoi
dezarhivata sau pot fi adaugate unul cate unul pe rand, intr-un folder gol din pagina cursului.

Folderele platformei sunt destinate exclusiv pentru organizarea fisierelor, si nu pentru alte tipuri de
resurse sau activitati.

Adaugarea unui folder in curs
Daca aveti deja un folder de fisiere, deja creat, 1l puteti incarca pe platforma in doua metode:

Page4‘ 3
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Prima metoda (mai rapida)

1. Activati Actions Menu > Turn editing on

2. Drag-and-drop folderul arhivat in sectiunea cursului

3. Faceti click pe actiunea pe care doriti s-o efectuati asupra folderului (in cazul nostru ,Unzip”) si
selectati ,,Upload”

4. Daca este necesar puteti edita titlul folderului facand click pe iconita in forma de creion.

Whatydo you want to do with the file
Vocabularylists zip?

@ Unzip files and create folder
" Create file resource
C Add a SCORM package

Topic 1

Upload Cancel

e T

5]
0¥

A doua metoda

1. Activati Actions Menu > Turn editing on
2. Selectati link-ul ,Add an activity or resource”, iar din lista afisata selectati ,, Folder”.

v General

Name"* |

Description® | show editing toals

Display description on
course page ()

+ Content

Files Maximum size for new files: Unlimited

& Add 4 Create folder v

» [l Files

-

You can drag and drop files here to add them

Display folder contents | on a separate page v

Show sub-folders ¢
expanded (1)

3. Tnsectiunea ,General”, se configureaza titlul folderului si o scurtd descriere daca se doreste.
4. Tn sectiunea ,Content” adaugati folderul dorit sub forma de arhiva.
5. Pentru a dezarhiva folderul, faceti click pe thumbnail-ul foderului si selectati ,,Unzip”

Telefon: +40 0262 226 778 » Fax: +40 0262 226 778
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Files

6. Mai faceti inca o data click pe thumbnail-ul folderului arhivat, iar de data aceasta selectati
,Delete”, pentru a sterge folderul initial.

7. Setati modul de afisare a folder-ului, daca doriti sa restrictionati accesul la el sau ,Common
module settings”.

8. Salvati modificarile.

Crearea unui nou folder si Incarcarea fisierelor in el
Folositi aceasta metoda daca doriti sa creati un folder in curs si apoi sa incarcati fisiere in el.

Activati Actions Menu > Turn editing on

Selectati link-ul ,,Add an activity or resource”, iar din lista afisata selectati ,, Folder”.

Adaugati numele folder-ului si / sau o descriere

Selectati ,, Create folder” daca doriti sa creati un subfolder

Incarcati fisierele dorite

Setati modul de afisare a folder-ului, daca doriti sa restrictionati accesul la el sau ,Common
module settings”.

7. Salvati modificarile.

oV A wWNRE

Afisarea continutului unui folder (,,Display folder contents”)
Selectati daca doriti folderul afisat pe o pagina separata (mod implicit) sau in pagina principald a
cursului cu sau fara subfoldere, precum si modul de afisare a subfolderelor.

Afisare buton de download folder (,Show download folder
button”)

Daca acesta optiune este activata, atunci va fi afisat un buton, astfel incat studentii sa poata descarca
continutul folderului sub forma unei arhive, pentru vizualizare offline.
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Download folder

)

Edit

Label

O resursa de tip ,,Label” serveste ca distantier Intr-o pagina a cursului. Poate fi folosita pentru a adauga
text, imagini sau continut multimedia printre alte resurse si activitati din diferite sectiuni ale cursului.
Este o resursa foarte versatila si poate ajuta la imbunatatirea aspectului unui curs, daca este folosit cu
prudenta. Bannere sau diverse descrieri pot fi adaugate in ,,Label” pentru a distinge si evidentia diferite
zone.

Pe de alta parte, utilizarea excesiva a continutului multimedia (audio, video) in , Label” poate incetini
incarcarea unei pagini de curs.

O resursa de tip ,Page” creeaza un link catre o pagina care afiseaza continutul creat de profesor.

Editorul de text permite paginii sa afiseze mai multe tipuri de continut, cum ar fi text simplu, imagini,
audio, video, cod incorporat sau o combinatie dintre toate acestea.

in anumite cazuri, ar putea fi de preferat s folositi resursa ,Page” in loc sd incircati un document
word, Tn mod special daca documentul contine text care trebuie doar citit si care nu trebuie sa fie
descadrcat.

URL

O resursa de tip ,,URL” permite adaugarea in curs, a unui link catre un site web sau fisier online.
Profesorii pot utiliza resursa ,URL” pentru a le oferi cursantilor link-uri web pentru research,
economisind timp si efort cursantului in a scrie manual adresa. Adresele URL pot fi afisate in diverse
moduri - de exemplu, deschizandu-se intr-o fereastra noua, astfel incat un student sa poata accesa si
utiliza link-ul, sa-1 inchida si sa se intoarca usor la pagina originala a cursului.

Activitati
ctivitati
Activitatile sunt materiale interactive, ce impun participarea cursantilor. Pentru a adauga o activitate
la un curs, intram n curs, si selectam Actions Meniu > Turn editing on din coltul din dreapta sus, si din

meniul ,,Add an activity or resource” corespunzator unei sectiuni a cursului, facem alegerea dorita. Se
completeaza campurile cerute si se editeaza in mod convenabil setarile. Ulterior putem reveni oricand
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la aceste setari, pentru a le modifica. La final apasam butonul ,Save and display” de la baza paginii,
pentru a vedea activitatea creatd, sau ,Save and return to course”.

Assignments

Activitatea de ,Assignment” ofera un mod in care cursantii pot trimite lucrari profesorilor pentru a fi
notate si pentru a primi feedback inapoi. Lucrarea poate fi scrisa ca text online sau sub forma de fisiere
incarcate, de orice tip pe care dispozitivul profesorului sa le poata citi. Studentii pot trimite lucrari
individuale sau in grup.

Setari activitate ,,Assignment”

n sectiunea ,,General” se configureaza numele activititii, descrierea si se poate incérca un fisier care
poate folosi ca exemplu cursantilor.

Se pot activa setdri pentru acces restrictionat in ,Restrict access” si setari pentru completarea activitatii
in ,Activity completion”.

Availability

e Allow submissions from” — Aceasta optiune impiedica cursantii sa trimita o lucrare, inainte de
data afisata, dar nu ascunde scopul si nici instructiunile sau materialele incluse.

e ,Due date” — Trimiterea lucrarilor sunt inca permise dupa aceasta data, dar vor fi marcate ca
intarziate.

e ,Cut-off date” — Dupa aceastd data, cursantii nu vor putea trimite lucrari, iar butonul de
trimitere va disparea.

e ,_Remind me to grade by...” — Trebuie sa fie introdusa o data aici pentru ca activitatea sa fie
afisata in blocul ,,Course overview” a profesorului si in Calendar. Se va afisa abia atunci cand cel
putin un cursant a trimis o lucrare.

Submission types
Aici se poate selecta modul in care cursantii isi vor trimite lucrarea.

Nota: Daca ,Submission comments” sunt activate, cursantii vor putea adauga o nota profesorului lor la
trimiterea lucrarilor.

e ,Online text” — Cursantii isi redacteaza lucrarile lor, direct in platforma folosind un editor de
text. Este posibil sa fie setata o limita de cuvinte pentru textul redactat.

e File submissions” — Cursantii pot incarca unul sau mai multe fisiere de orice tip pe care
profesorul le poate deschide.

Feedback types

e ,Feedback comments” — Cu aceasta optiune activata, utilizatorii care noteaza pot lasa
comentarii pentru fiecare trimitere.

Telefon: +40 0262 226 778 » Fax: +40 0262 226 778
WEB: http://www.holisun.com e E-mail: info@holisun.com

Page4‘ 7




we bring you the future HOL'SU N \3
I - -
www.holisun.com

e ,Feedback files” — Aceasta optiune permite utilizatorilor care noteaza, sa incarce fisiere cu
feedback Tn momentul notarii. Aceste fisiere pot fi lucrarile cursantilor, notate, fisiere cu
feedback, feedback audio. Aceasta optiune activeaza coloana , Feedback Files” in sectiunea de
notare a activitatii (butonul ,,View all submissions”).

e ,Comment inline” — Aceasta optiune permite unui profesor sa ofere feedback sub forma de
comment, direct |la o lucrare trimisa sub forma de ,,text online”.

Submission settings

e Require students click submit button”

o Daca este setat ,No”, atunci cursantii pot face modificari in orice moment. (Daca un
profesor doreste sa 1i blocheze cursantului posibilitatea de a-si modifica lucrarea,
trebuie sa acceseze ,View all submissions”; sa localizeze cursantul si din coloana
,Editare”, sa faca click pe link-ul ,Edit” din dreptul cursantului respectiv si sa selecteze
»Prevent submission changes”).

o Daca este setat ,Yes”, cursantii pot incarca ciorne ale lucrarii pana cand sunt multumiti
de rdspuns si gata sa trimita. Facand click pe butonul de trimitere ii transmite
profesorului ca a terminat redactarea si ca doreste ca munca sa-i fie notata. Acestia nu
isi mai pot edita lucrarea. Daca trebuie sa o schimbe din nou, atunci trebuie sa solicite
profesorului sa ii marcheze lucrarea trimisa, la starea de ciorna din nou (Profesorul
acceseaza ,View all submissions” > localizeazd cursantul in listd > Edit > Revert the
submission to draft).

E]’ Grade ( E’ Grade

Revert the submission to draft Prevent submission changes
]

With selected... [Lock submissions =] &
Lock submissions

Revert the submission o draft status

e Attempts reopened — Daca ,Require students click submit button” este activat, atunci cursantii
pot trimite o lucrare o singura data. Puteti schimba acest lucru aici prin optiunea ,Manual” si
sa redeschideti posibilitatea de trimitere, sau puteti seta ,Automatically until pass”, pentru ca
cursantii sa poata retrimite o lucrare pana obtin o nota de trecere.

e Maximum attempts — Decideti la cate retrimiteri au dreptul cursantii.

Groups submission settings

Permite cursantilor sa colaboreze la o singura tema. La notare, profesorul poate alege sa dea o nota
comuna si feedback pentru toti elevii din grup sau sa dea note individuale si feedback fiecarui membru.

e ,Require group to make submission” - Daca este activat, utilizatorii care nu sunt membri ai unui
grup nu vor putea trimite lucrari.
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e Require all group members submit” - Aceasta setare va apdrea doar daca profesorul a bifat
butonul ,Require students click submit button”. Lucrarea nu va fi clasificata drept ,trimisa”
decat daca toti membrii grupului au adus o contributie. Dupda ce un student trimite o
contributie, ceilalti membri ai grupului vor putea vedea cine mai are de trimis.

Utilizare activitate ,,Assignment”
Pentru a sti cum vede cursantul tema, putem comuta pe rolul de student, accesand link-ul ,,Switch role
to...” din meniul utilizatorului, aflat in stanga sus a ecranului.

Assignment 3

For this assignment you need to write a 3,000 word essay on wikis and how they can be used in teaching and
learning. Watch the video below:

¥ Moce info

Read this article: Everything you should know about wikis, Educause Learning Initiative

Submission status

)

Submission status  Nothing has been submitted for this assignment '

Grading status Not graded
Due date Friday, 29 June 2012, 3:05 PM
Time remaining 6 days 23 hours

ladd submission

Profesorul poate accesa link-ul ,,View all submissions”. Va fi condus la o pagina pe care apare un tabel
cu toti cursantii care au trimis o lucrare si numele acestora.

BigBlueButtonBN

Activitatea ,BigBlueButtonBN” permite crearea unei sesiuni de conferinta video, in cadrul unui curs.
La nivelul acestei activitati, se definesc trei tipuri de roluri ce pot fi atribuite participantilor:

e Rolul de moderator — are drepturi de moderare / administrare a sesiunii de conferinte si asupra
participantilor la conferinta.

e Rolul de prezentator — are control asupra prezentarii, asupra whiteboard-ului si asupra
intrumentelor ce tin de desfisurarea prezentarii. in mod implicit, platforma atribuie rolul de
prezentator, moderatorului, dar pot fii doua persoane diferite, unul moderator celalalt
prezentator.

e Rolul de spectator —are drepturi limitate, poate folosi modul de chat, panoul de ,,Shared Notes”
si poate vizualiza o prezentare.
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Setari activitate , BigBlueButtonBN”
Selectati tipul conferintei: ,,Room/Activity with recordings”, ,Room/Activity only” sau ,Recordings
only”.

Tn sectiunea ,,General settings” se poate seta numele activitatii (obligatoriu), o descriere (faceti click pe
link-ul ,,Show more”) si daca se doreste trimiterea unui notificari utilizatorilor cu privire la crearea sau
modificarea acestei activitati.

n sectiunea ,Activity/Room settings” puteti restrictiona accesul cursantilor la o conferint, pand atunci
cand un profesor (moderator) se alatura acelei conferinte. Tot in aceasta sectiune puteti crea un mesaj
personalizat de bun venit care apare in partea de sus a ferestrei de chat atunci cand utilizatorii se
alatura sesiunii de conferinta.

n sectiunea , Participants” puteti selecta si ad3uga participanti la conferintd, atribuindu-le rolurile pe
care le vor avea in cadrul conferintei: de simplu spectator sau de moderator / prezentator. Puteti
selecta utilizatorii dupa rolul pe care il au in cadrul platformei de e-Learning sau puteti selecta un
anumit utilizator caruia sa-i dati acces in platforma.

n sectiunea ,Schedule for session” puteti programa sesiunea de conferinta.

De asemenea, se pot activa setdri pentru acces restrictionat in ,Restrict access” si setari pentru
completarea activitatii in ,, Activity completion”.

Utilizare activitate ,BigBlueButtonBN”

Tn mod implicit, un utilizator care primeste rolul de spectator in activitatea de conferinta va avea
drepturi limitate in cadrul acesteia. Mai exact, un utilizator cu rol de spectator va putea in mod implicit
sa foloseasca modulul de chat atat cel public, cat si cel privat cu un anume utilizator (click pe numele
utilizatorului din lista ,,Users” si selectati ,Start a private chat”), va putea contribui la panoul de ,,Shared
Notes”, sa isi exporte acest panou si sa vizualizeze prezentarea prezentatorului. Spectatorul va putea
avea acces la ,,Whiteboard” sau sa preia controlul asupra prezentari doar daca moderatorul 1i acorda
aceste drepturi. Retineti ca in mod implicit un utilizator nu va putea interactiona cu slide-urile unei

prezentari.
MESSAGES ¢ Shared Notes
Public Chat B I USE& =EEDC [=4

shared notes

NOTES
shared notes 222

Shared Naotes

The Retrospective Meeting

{: N N .
USERS (2) Retrospective meetings are used o improve how you wark by laoking back at what has

. . . i
happened since last time and then decide how w change based on that, This is also called

e Student Unu (You) inspecting and adapting
(]

& When should you hold it?
a Super Teacher Your held this meeting at regular intervals, Usually at the end of each week, month ar spring,
(E]

How long should it be?

Telefon: +40 0262 226 778 » Fax: +40 0262 226 778
WEB: http://www.holisun.com e E-mail: info@holisun.com

PageS 0




we bring you the future HOL'SU N \}
I - -
www.holisun.com

MESSAGES

Public Chat
NOTES

Shared Nates

USERS (2)

o Student Unu {You)
(4]

E@ Super Teacher ¢ Starta private chat
(&)

1. Bei the Singr

Y

2 Gudbar D

Un utilizator cu rolul de moderator va avea drepturi depline in sesiunea de conferinta. Acesta este in
mod implicit si prezentator. Acesta poate folosi meniul de ,Manage users”, de unde va putea seta pe
mute microfonul tuturor participantilor la conferinta, va putea descarca o lista cu participantii, va putea
restrictiona accesul utilizatorilor cu rol de spectator la anumite functionalitati (blocarea webcam-ului,
blocarea microfonului, blocarea chat-ului privat, blocarea accesului la , Shared Notes”) si va putea
imparti participantii in mai multe grupuri de discutii pentru a putea efectua diverse activitati interactive

de grup intr-un anumit timp limita.
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&

Clear all status icons

& jo

Mute all users

1]

Mute all users except
presenter

Save user names

B Lock viewers

B Create breakout rooms

3 Write closed captions

¢ Slidez v > = F) e =2

Lock viewers

These options enable you to restrict viewers from using specific features.

Feature Status

Share webcam Unlocked C‘
See other viewers webcams Unlocked C‘
Share microphone Locked ()
Send Public chat messages Unlocked C‘
Send Private chat messages Unlocked C’
Edit Shared Notes Unlocked C’
See other viewers in the Users list Unlocked C,

Cancel
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Close

Breakout Rooms

=]

Tip: You can drag-and-drop a user's name to assign them to a specific breakout room.

Number of rooms Duration (minutes)

2 v 12 e ®

Randomly assign

#| Allow users to choose a breakout reom te join

Mot assigned (1) Room 1 Room 2

Super Teacher Student Unu

Un moderator va putea selecta un utilizator pentru a-i acorda drepturi de prezentator. Din acest
moment utilizatorul respectiv va putea interactiona cu whiteboard-ul, va putea naviga printre slider-
ele prezentarii, va putea face screen share si crea sondaje. Tot moderatorul poate sa-i retraga aceste

drepturi selectand din meniul ,Actions” >, Take presenter”.

MESSAGES

Public Chat
CAPTIONS

Romana

MOTES

Super Teacher (You)
()

=

e Student Unu
(8]

Shared Notes

USERS (2) o

=

@ Super Teacher (You)
(]

o Student Unu
(&}

0 starta private chat

=1 Promote to moderator

(*) Remove user

£ Take presenter

De asemenea, un moderator poate atribui drepturi de moderator si altor participanti. Respectivii
utilizatori vor putea avea acces la functionalitatile de moderator ale conferintei, dar nu vor deveni

automat si prezentatori (nu vor putea prelua control asupra prezentarii). Pentru a deveni prezentatori
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fie isi vor atribui ei insdsi acest rol, fie il pot primi de la moderatorul initial. Pentru ca un moderator sa
preia rolul de moderator de la un alt utilizator va face click pe numele utilizatorului respectiv si va

selecta ,,Demote viewer”.
MESSAGES
MESSAGES

Public Chat
Public Chat

NOTES
NOTES

Shared Motes
Shared Notes

USERS (2
(2) & USERS (2) &
=
Super Teacher (You) =
(5] Super Teacher (You)
(&)
eﬂ Student Unu & Starta private chat 9 Student Unu (0 Starta private chat
T Make presenter o L Make presenter

=1 Promote to moderator

,g. Demote to viewer

()
%) Remove user (*) Remove user

Un moderator poate scoate un participant, afara din conferinta: Click pe numele utilizatorului > Remove

user.

Din butonul din stanga jos, “Actions” un prezentator poate lansa un sondaj, poate incarca un alt fisier
de prezentare, sau poate prezenta un video dintr-o sursa externa (ex: youtube).

= Startapoll

CJ Upload a presentation

¥ Share an external video

Pentru a face partajare de ecran, un prezentator va selecta ultimul buton din sirul de butoane din

centru jos.
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Share your screen

in partea dreaptd a ecranului prezentatorul va putea accesa instrumentele necesare pentru a face
notari pe whiteboard-ul cu prezentarea. Ultimul buton din lista, , Turn multi-user whiteboard on”, va
permite celorlalti participanti sa facad note pe prezentare, dar retineti ca acestia, tot nu vor putea naviga
printre slider-ele prezentarii.

Ao Hitator

1 amid

Turn multi-user whiteboard on

Pentru a incepe inregistrarea conferintei, un moderator poate selecta butonul ,Start recording” centru
sus, iar pentru a pune pauza pe inregistrare in aceeasi zona, va face click pe timer-ul de inregistrare.

Sesiunea 1 Start recording :I Sesiunea 1 (O o125

Pause recording

La finalul conferintei participantii vor selecta ,,Logout”, pentru a parasi conferinta, in meniul ,,Options”
din dreapta sus. Pentru un moderator va fi vizibil si butonul de ,,End meeting”, care va face posibila
inchiderea conferintei expulzandu-i automat pe toti cei care au ramas in conferinta.

3 C Make fullscreen

£ Settings
@ About
(@ Help )

=1 Keyboard shortcuts

[+ Logout
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Tnregistrarile unei conferinte vor fi addugate automat in platforma e-Learning, in pagina activitatii de
conferinta, de unde vor putea fi accesate.

Sesiunea 1

This conference room is ready. You can join the session now.

Join session

Inregistrari
Playback Meeting inregistrare Descriere Preview Data Durata

prezentare Sesiunea 1 Sesiunea 1 mar., 14 apr. 2020, 17:20 GTB Summer Time 1

prezentare Sesiunea 1 Sesiunea 1 e mar., 14 apr. 2020, 17:12 GTB Summer Time 0

Chat

Chat-ul permite participantilor sa aiba o discutie sincrona in timp real. Profesorul trebuie sa creeze mai
intai o camera de discutii, pentru care precizeaza momentul cand asteapta sa se autentifice cursantii.
Sesiunea se poate repeta pe parcursul cursului, sau poate avea loc o singura data.

Setari activitate Chat
Tn sectiunea General se adaugd setdri precum numele activitatii si descrierea.

Se pot activa setdri pentru acces restrictionat in ,Restrict access” si setari pentru completarea activitatii
in ,Activity completion”.

n sectiunea ,,Chat sessions” se poate seta:

e oradeincepere a urmatoarei sesiuni;

e cum dorim sa aiba loc repetarea sesiunii (aici putem alege intre a repeta sesiunea
zilnic/saptamanal la aceeasi ora, a nu o repeta sau a pastra mereu camera deschisa si a nu afisa
ora la care au loc conversatiile);

e perioada pentru care putem salva o transcriere a mesajelor, la ,Save past sessions”;

e daca toti utilizatorii pot vizualiza jurnalele de conversatie.

Utilizare activitate Chat
Cursantii pot accesa oricand chatul, nu doar la momentul stabilit. Ei pot sa comunice cu alti cursanti
care se afla acolo.

Telefon: +40 0262 226 778 » Fax: +40 0262 226 778
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Chat: How are you getting on?

A place 1o meet each Monday to discuss course progress and any issues you might have

Chat session will start in' 6 days 3 hows
Cick here to enter the chat now
Use more accessible nterface

View past chat sessions

Daca urmam linkul ,,Click here to enter the chat now”, vom folosi versiunea obisnuita de chat. Aceasta
prezinta la baza ferestrei o casetd de text pentru introducerea mesajului, care se trimite oricui este
autentificat la chat, la apasarea tastei Enter sau a butonului ,Send”. Fereastra de chat se actualizeaza
periodic, la fiecare 5 secunde.

,Use more accessible interface” - Versiunea fara frame-uri si JavaScript permite tastarea mesajului intr-
o caseta de text si trimiterea acestuia la apasarea butonuilui ,,Submit”.

Daca urmam linkul , View past chat sessions”, vom putea vedea toate sesiunile de chat. Fiecare dintre
ele poate fi vizualizata sau stearsa.

Choice

Activitatea ,Choice” permite profesorului sa puna cursantilor o intrebare cu variante multiple de
raspuns si sa colecteze raspunsurile acestora. Este ca un vot exprimat de acestia. Se poate folosi si la
testarea initiala in cadrul unei lectii.

Setari activitate Choice
n sectiunea General addugdm enuntul intrebérii si setdm dacd dorim s& afisdm optiunile pe orizontal
sau pe verticala (de obicei, raspunsurile arata mai bine pe verticald, mai ales daca sunt multe variante).

Se pot activa setari pentru acces restrictionat in ,,Restrict access” si setari pentru completarea activitatii
in ,Activity completion”.

Tn campul ,Allow choice to be updated” selectdm dacd permitem alegerii s3 fie actualizate (dacd da,
cursantul se poate razgandi, daca nu, studentul decide doar o data);

Daca la cdmpul ,, Limit the number of responses allowed” selectam , No”, oricati participanti pot alege
orice optiune; daca selectam ,,Yes”, campul ,Limit” de la optiunile de mai jos devine activ, permitandu-
ne sa stabilim numarul maxim de participanti care pot alege acea optiune de raspuns.

n continuare, se introduc variantele de raspuns dintre care trebuie s aleaga cursantii, in cAmpurile
,Option” si, eventual, valorile in campurile ,,Limit”. Daca sunt mai putin de 5 variante de raspuns, vom
[asa ultimele campuri necompletate.

Telefon: +40 0262 226 778 » Fax: +40 0262 226 778
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Daca sunt mai mult de 5 variante de raspuns, mai putem adauga cate avem nevoie, apasand butonul
»Add 3 field(s) to form”.

n continuare putem bifa in sectiunea , Availability” faptul ci dorim s3 precizdm perioada de timp in
care se accepta raspunsuri la aceasta alegere, apoi ni se permite stabilirea momentului initial si a celui
final.

Sectiunea Results

e ,Publish results” - stabilim cum publicam rezultatele (nu le publicam, le aratam cursantilor
imediat dupa ce au raspuns, le aratam cursantilor doar dupa momentul inchiderii alegerii, le
aratam mereu cursantilor).

e Privacy of results” - confidentialitatea rezultatelor (daca aratam numele si raspunsurile
cursantilor sau le pastram anonimatul);

e ,Show column for unanswered” - daca afisam o coloana pentru intrebari la care nu s-a raspuns
(permite cursantilor sa vada numarul celor care nu au raspuns).

Utilizare activitate Choice

Profesorul poate vedea raspunsurile oferite de cursanti, urmand link-ul din dreapta sus al paginii
activitatii , View x responses”. Se va deschide un tabel cu cate o coloana pentru fiecare raspuns, in care
se afla numele si imaginea cursantilor care au ales acea varianta. Rezultatul poate fi descarcat intr-un
format ales de utilizator, prin apasarea unuia dintre cele trei butoane de la baza paginii.

Database

Activitatea ,Database” permite utilizatorilor sa construiasca in colaborare, sa afiseze si sa interogheze
o banca de articole privitoare la un anumit subiect. Articolele pot contine imagini, fisiere, numere,
texte, URL-uri si altele.

Setari activitate Database

n sectiunea General se adaug setdri precum numele activitatii si descrierea.

Se pot activa setari pentru acces restrictionat in ,,Restrict access” si setari pentru completarea activitatii
in ,Activity completion”.

Entries

La ,,Approval required” profesorul stabileste daca intrarile elevilor trebuie aprobate de catre cineva cu
un rol corespunzétor, inainte ca ele s fie vizibile tuturor utilizatorilor. In acest fel elevii pot fi ajutati sa
produca un lucru de calitate, oferindu-le feedback Tnainte de a le aproba articolul.

La ,,Allow comments on entries” profesorul stabileste daca permite introducerea de comentarii la
articole. Tn caz afirmativ, acestea se vor vedea doar in modul de vizualizare a cate unui singur articol pe
pagind. Comentariile ofera feedback cursantilor si ii pot ajuta sa imbunatateasca ce au lucrat.

Telefon: +40 0262 226 778 » Fax: +40 0262 226 778
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La ,Entries required before viewing” profesorul scrie cate articole trebuie sa elaboreze fiecare cursant,
pentru a putea vedea ceea ce au lucrat ceilalti utilizatori. Tnainte de implinirea acestui numar, cursantul
vede doar pagina de introducere a unui nou articol.

Availability
»Available from” si ,,Available to” putem selecta cand poate fi baza de date vizibila cursantilor.

Daca bifam ,, Read only from” si ,,Read only to”, putem selecta datele intre care baza de date se poate
consulta, dar nu edita.

Setarile ,,Available from/to” suprascriu setarile ,,Read only from/to”.
Ratings

n sectiunea , Ratings” se stabileste care sunt rolurile care au permisiunea de a nota articolele. Rolurile
se pot stabili folosind meniul Actions Menu > Permissions din cadrul activitatii.

»Aggregate type” defineste cum sunt combinate scorurile pentru a obtine nota finald din catalog.
Putem alege intre a face media scorurilor, a considera numarul articolelor notate, minimul, maximul
sau suma scorurilor. Daca alegem ,No ratings”, activitatea nu va aparea in catalog.

Utilizare activitate Database

Dupa apasarea butonului ,,Save and display”, suntem condusi catre operatia de definire a campurilor,
pentru a stabili structura bazei de date si a determina felul informatiilor care pot fi introduse de catre
cursanti.

Campurile (,,Fields”) pot avea diverse tipuri prestabilite:

- ,Checkbox” permite cursantilor sa bifeze una sau mai multe casete de validare;

- ,Date” permite cursantilor sa aleaga ziua, luna si anul dintr-o lista derulanta;

- ,File” permite cursantilor sa incarce un fisier din calculator;

-, Picture” permite cursantilor sa incarce un fisier imagine;

-, Latitude/longitude” permite elevilor sa introduca o locatie geografica;

- ,Menu” permite elevilor sa faca o alegere dintr-un meniu derulant;

- ,Multimeniu” (selectie multipld) permite elevilor sa faca alegeri multiple intr-un meniu
derulant, tinand apasata tasta Ctrl sau Shift;

- ,Number’ permite elevilor sa introduca un numar;

- ,Radio button” permite elevilor sa selecteze o singura optiune dintr-o lista;

-, Text” permite elevilor sa introduca un text de pana la 60 caractere;

-, Textarea” permite elevilor sa introduca un text mai lung de 60 de caractere si sa-I formateze;

- ,URL" permite elevilor sa introduca un URL.

Telefon: +40 0262 226 778 » Fax: +40 0262 226 778
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Atunci cand dorim sa cream un camp al unei baze de date, dupa alegerea tipului trebuie sa introducem
numele, descrierea sa si, eventual, sa precizam alte optiuni (de exemplu marimea unei imagini la
vizualizarea individuala si la vizualizarea in lista sau numarul de linii si de coloane ale unei zone de text).

View list View single Search Add entry Export Templates Fields Presets

Text field

Field name |pume
Field description |Numele componentei
Required field (@
Allow autolink

Add Cancel

Campurile create apar pe ecran intr-un tabel. La finalizarea operatiei de definire a cdmpurilor, apasam

butonul Salveaza.

View list View single Search Add entry Export Templates Fields Presets
Field added x
Field name Field type Required Field description Action
Nume I Text field Yes Numele componentei oo
magine [a] Picture field Yes maginea componentei o o
Descriere A Textarea field Yes Descrierea componentei o o
Create a new field | Choose... :
Default sort field | Time added # Ascending * = Save

Pasul urmator este editarea sablonului pentru interfata cu utilizatorul in , Templates”. Definirea
campurilor produce un sablon implicit, care ulterior poate fi cu usurinta imbunatatit.

Sabloanele sunt pagini HTML care contin tag-uri pentru lucrul cu baze de date. In partea stanga a

ecranului se gaseste o lista a tag-urilor disponibile, de unde, prin dublu-click, le putem adaugainsablon. &

La finalul operatiei de editare, salvam sablonul, sau il resetam daca nu suntem multumiti. \%
eV}
T
[}
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View list View single Search Add entry Export Templates Fields Presets

List template Single template Advanced search template Add template RSS template CS5 template

Javascript template

Defines browsing interface for a single entry

Available tags Single template

Fields
Nume - [[Nume]] 1 A~ B 1 = E | % S M-
Imagine - [[Imagine]]
Descriere - [[Descriere]] Nume:[[Numel]
Actions - -
Edit - ##edites Imagine:[[Imagine]]
Delete - ##delete## Descriere:[[Descriere]]

Approve - ##approve##

Undo approval - ##disapprove

Export - ##export## ##edité# ##deleted# ##approve## ##disapprove## ##export##
Other

Timnn mcdded  Hlaien AR

Reset template
(i) A draft version of this text was automatically restored.

Save template

Din acest moment utilizatorii pot adauga articole, utilizand fila ,,Add entry”.

Disable editor

Dupa adaugarea articolelor, acestea pot fi vizualizate unul sub altul pe fila , View list” sau cate unul pe
pagina, pe fila , View single”.

Feedback

Activitatea ,Feedback” va permite sa creati si sa efectuati sondaje pentru a colecta feedback. Spre
deosebire de activitatea , Survey”, va permite sa va scrieti propriile intrebari, decat sa alegeti dintr-o
lista de intrebari pre-scrise si spre deosebire de activitatea , Quiz”, puteti crea intrebari fara puncta;j.
Activitatea de feedback este ideala pentru evaluarile cursului sau ale profesorilor.

Setari activitate Feedback
n sectiunea General se adaugd numele activitatii si descrierea.

Se pot activa setari pentru acces restrictionat in ,,Restrict access” si setari pentru completarea activitatii
in ,Activity completion”.

Availability
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Aici puteti alege cand utilizatorii pot completa feedback-ul.

Question and submission settings

~ Question and submission settings
Record user names
Anonymous v

Allow multiple submissions (7

Mo |w

Enable notification of submissions (7
Mo |w

Auto number questions (0

Mo |v

e ,Record User Names” - Alegeti aici daca aratati sau nu numele utilizatorilor care completeaza
feedback-ul.

o Allow multiple submissions” - Alegeti aici daca permiteti sau nu utilizatorilor sa completeze
feedback-ul de mai multe ori.

e ,Enable notification of submissions” - Daca este setat pe ,Yes”, profesorii vor primi notificari
atunci cand utilizatorii trimit feedback.

e ,Auto-number questions” - Daca este setat pe ,Yes”, atunci intrebadrile vor fi numerotate
automat.

After submission

- After submission

Show analysis page
Mo [
Completion message

Paragraph  + R | J || ; i

Your responses are very useful and we appreciate your help.

Fath: p = sirong

Page6 2
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»Show analysis page” - Rezultatele rezumate pot fi afisate respondentilor sau ardatate numai
profesorilor.

,Completion message” - Acest lucru va permite sa prezentati utilizatorilor un mesaj personalizat dupa
ce au raspuns intrebarilor.

»Link to next activity” - Acest lucru va permite sa adaugati un link catre o alta activitate sau site web la
care doriti sa i redirectionati odata ce au raspuns la intrebari.

Utilizare activitate Feedback

Dupa configurarea unei activitati ,, Feedback”, adaugati intrebari facand click pe fila ,Edit questions” si
selectand tipul de intrebare din meniul drop-down. Adadugati detaliile intrebarii si faceti click pe , Save
question”.

Overview Edit questions

Add question

Choose... v

Add a page break
Captcha

Information

Label

Longer text answer
Multiple choice
Multiple choice (rated)
Numeric answer
Short text answer

Optiuni standard
Urmatoarele optiuni se aplica la marea majoritate de tipuri de intrebari.

e Position” - Acest numar controleaza ordinea intrebarilor. Pozitia 1 o are intrebarea cea mai
apropiata de partea de sus a paginii, asa ca atunci cand creati sau editati o intrebare, puteti
alege din lista verticala a pozitiilor disponibile (care va varia in functie de cate alte intrebari
existd). De asemenea, puteti aranja intrebarile facand click pe sagetile in sus si in jos din ecranul
principal de addugare a intrebarilor.

e _Required” — La aceste intrebari raspunsul este obligatoriu

Captcha

Un test pentru a va asigura ca o persoana reala completeaza formularul si nu un program automat de
spamm.

Page6 3
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Information

Acest element va permite sa afisati cursul si / sau categoria in care se afla feedbackul.
Label

La fel ca o eticheta standard, aceasta va permite sa adaugati text intre intrebari care ofera explicatii
suplimentare sau sa impartiti feedback-ul in sectiuni.

Longer Text Answer

Acest tip de intrebare este pentru crearea unei casute de text (specificati cat de mare va aparea in
randuri si coloane) la care utilizatorii pot scrie un raspuns mai lung.

Multiple choice
Aceasta intrebare va ofera trei alternative:

1. ,Multiple choice single answer” — Permite setarea mai multe optiuni de ales, cu butoane radio.
Prima optiune poate fi ,Not selected”. Doar o optiune poate fi aleasa.

2. ,Multiple choice, multiple answers” — Permite selectarea mai multor optiuni.

3. ,Multiple choice - single answer allowed (drop-down menu)”- VA afisa un meniu drop-down din
care poate fi selectat un singur raspuns.

Numeric answer

Folositi aceasta intrebare cand trebuie sa primiti un numar ca raspuns. Puteti sa specificati intervalul
intre care numarul trebuie sa se regaseasca.

Multiple Choice (Rated)

Este similara cu celelalte intrebari cu optiuni multiple, cu exceptia faptului ca fiecare optiune are o
valoare numerica asociatd cu aceasta. Aveti posibilitatea de a alege sa utilizati butoane radio sau un
meniu drop-down pentru a afisa optiunile de raspuns.

Short Text Answer

Va ofera posibilitatea de a folosi un tip de intrebare care necesita un singur raspuns text, cu o caseta
de intrare care are un numar stabilit de caractere.

Dependence item and Dependence value

Este posibil sa directionati utilizatorul catre intrebari specifice, in functie de un raspuns anterior. De
exemplu, daca acestia raspund , Da” la intrebarea , Aveti o masina?”, vor fi directionati catre o alta
intrebare decat daca ar fi raspuns ,,Nu”. Pentru a seta intrebari dependente:
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Configurati intrebarea initiala si dati-i un nume in campul , Label”

Required ¥

Question Do you have a car?
Label CarYesNo
Adjustment vertical v
Multiple choice type Multiple choice - single answer v
Do not analyse empty submits No v
Hide the "Not selected” option Yes ¥

Multiple cheoice values
Use one line for each answer!

Yes
No

Adaugati un ,Page break”

Adaugati intrebarea la care se va ajunge daca (de exemplu) utilizatorul raspunde ,,Da”.
Tn ,,Dependence item”, selectati eticheta (,,Label”) primei intrebari.

in ,Dependence value” tastati raspunsul dependent (cum ar fi ,Da” in exemplul nostru.)

Question Do you own the car or is it rented/borrowed?

Label
Adjustment vertical A
Multiple choice type Multiple choice - single answer ¥
Do not analyse empty submits Mo r

Hide the "Not selected™ option Yes *

Multiple choice values
Use one line for each answer!

o it
am renling or borrowing it

Dependence item (7) CaryYeshNo r

Dependence value Yes
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e Urmati acelasi proces pentru celdlalt raspuns (cum ar fi ,Nu”)

Forum

Forumul este un instrument pentru discutii asincrone. Profesorul poate solicita tuturor cursantilor
inscrisi la curs sa se inscrie la un forum; astfel acestia vor primi prin email instiintari la aparitia fiecarui
nou post si vor putea comunica oricand intre ei si cu profesorul.

Exista 5 tipuri de forumuri:

4

Standard forum for general use

A single simple discussion

Each person posts one discussion

Q and A forum

Standard forum displayed in a blog-like format

Standard forum for general use

e Standard forum for general use” — Tipul obisnui de forum, intalnit in mod general in care
oricine poate initia oricand o discutie.

e ,Single, simple discussion” — Permite crearea unei singure discutii la care poate rdaspunde
oricine.

e ,Each person posts one discussion” — Permite oricarui cursant sa posteze o singura discutie, la
care poate raspunde oricine.

e ,Qand A forum” — Cere ca fiecare cursant sa posteze propria sa interventie fnainte de a putea
vedea contributiile celorlalti

e ,Standard forum displayed in a blog-like format” — Fiecare poate incepe in orice moment o
discutie, iar subiectele sunt afisate sub forma unui blog.

Setari activitate Forum
Atunci cand initiem crearea unui forum, in sectiunea General trebuie sa i precizam numele, sa decidem
de ce tip dorim sa fie si sa oferim o scurta descriere a sa.

Attachments and word count

La ,,Maximum attachment size” precizam dimensiunea maxima a fisierului ce poate fi atasat la un post
pe forum.

La ,,Maximum number of attachments” precizam numarul maxim de fisiere ce pot fi atasate la un post
pe forum.

Subscription and tracking

La , Subscription mode” trebuie sa alegem un mod de inscriere la forum.
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Forced subscription
Auto subscription
Subscription disabled

Primul mod permite participantilor s§ aleagd dac se inscriu la forum. in al doilea mod participantii se
nscriu automat si nu pot sa renunte la aceasta. in al treilea mod participantii inscriu automat la inceput,
dar ulterior pot renunta. Ultimul mod nu permite inscrierea.

»Read tracking” - Poate avea doua valori: optional (participantii pot alege daca se aboneaza sau nu la
primirea mesajelor) si dezactivat (abonarea este dezactivata).

Post threshold for blocking

»Time period for blocking” - Precizam o durata, de la o zi pana la o saptamana, daca dorim sa putem
bloca cursantii, sau nu bloca in caz contrar.

La,, Post threshold for blocking” precizam numarul maxim de postari pe care le poate efectua un cursant
in perioada de timp precizata anterior.

,Post threshold for warning” reprezinta dupa cate postari se trimite cursantilor un avertisment.
Ratings
n sectiunea , Ratings” putem preciza care sunt rolurile care permit operatia de evaluare.

»Aggregate type” stabileste cum vor fi combinate evaluarile pentru a obtine nota finala din catalog.
Alegem ,,No ratings” daca activitatea nu va aparea in catalog.

Mo ratings +

Average of ratings
Count of ratings
Maximum rating
Minimum rating

| Sum of ratings

»Restrict ratings to items with dates in this range” permite sa limitam evaluarea posturilor doar la cele
publicate intr-o anumita perioada.

Utilizare activitate Forum

Profesorul care a creat un forum trebuie ca ulterior s3 il gestioneze. In primul rand este bine s
informeze cursantii cat de des (zilnic, saptamanal etc.) va intra pe forum si va raspunde la mesajele lor.
Trebuie sa stabileasca si niste reguli de comportament privitoare la limbaj, la subiectele abordate si
altele. Cursantii trebuie ajutati sa inteleaga diferenta dintre un forum social si unul academic. Calitatea
postarilor cursantilor poate fi influentatd si de notele primite la evaluarea acestora. In cele din urma,
daca situatia scapa de sub control, profesorul poate sterge posturile nedorite de pe forum.
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Crearea filmelor

Ce programe pentru crearea filmelor cunoasteti?

Separa grupuri | Toti participantii +

Adauga tema

Movie Maker
de catre Super User- luni, 14 septemnbrie 2015, 14:23

Windows Live Movie lMaker este un program gratuit de creare a filmelor pentru Vista si Windows 7.

Modifica | Sterge
Discuta acest subiect (0 replici in total)

Atunci cand un fir de discutie devine foarte lung, el poate fi arhivat si mutat intr-un forum, special creat
in acest scop, de obicei la inceputul sau la finalul cursului. Pentru aceasta se alege ,Move this discussion
to...”, aflat in partea dreaptd sus a unui fir de discutie, apoi se apasa butonul ,,Move”. In locul discutiei
mutate, se poate pune un post nou, cu un sumar al acesteia.

Crearea filmelor

Movie Maker

Avrata replicile intr-o forma de cuib v | | Mutd aceasta discutie in._ ¥

Movie Maker
de catre Super User- luni, 14 septembrie 2015, 14:23

Windows Live Movie Maker este un program gratuit de creare a fimelor pentru Vista si Windows 7.

Moedifica | Sterge | Raspunde

Re: Movie Maker
de catre Student Test 01- luni, 14 septembrie 2015, 14:35

Are posibilitatea de a inregistra comentarii vocale?

Arata parinte | Moedifica | Separare | Sterge | Raspunde

O alta practica recomandata este de a stabili cate un mic grup de cursanti moderatori pentru fiecare
forum sau discutie. Acesti cursanti trebuie sa se pregateasca bine pentru a stapani subiectul si a
raspunde la intrebarile de baza. Lor li se poate permite sa evalueze posturile colegilor lor, sa arhiveze
firele de discutie si sa scrie rezumatele pentru acestea.

Glossary

Glosarul este ca un dictionar intretinut de participanti. Fiecare disciplina are proprii termeni de
specialitate, cuvinte noi, acronime, prescurtari. In cadrul oricdrui curs putem elabora un set de termeni
cu definitiile lor, definitii care sa poata fi accesate cu usurinta prin intermediul linkurilor.
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Profesorul creeaza de obicei un glosar principal in sectiunea generala de la Tnceputul cursului si mai
multe glosare secundare in alte sectiuni, unde sunt necesare. Acestea din urma pot fi configurate
pentru a fi editate si comentate de cursanti. In glosarul principal pot fi importate intrarile din cele
secundare. Daca acest import nu este necesar, atunci putem crea doar glosare secundare.

Setari activitate ,Glossary”
Pe pagina pentru crearea unui glosar, in sectiunea General precizam numele si o scurta descriere.

Glosarul global are termeni accesibili de pe intregul site, nu doar dintr-un curs. De aceea doar
administratorul poate crea un glosar global.

La , Glossary type” precizam daca dorim sa cream un glosar principal sau unul secundar.

Entries

La ,,Approved by default” decidem daca dorim ca intrarile sa necesite aprobarea unui profesor inainte
de a deveni vizibile pentru toti participantii.

LJAlways allow editing” precizeaza daca studentii isi pot edita intrarile doar intr-o perioada alocata, sau
vor putea face acest lucru oricand.

La ,,Duplicate entries allowed” specificam daca permitem sa existe mai multe intrari cu acelasi nume.

La ,Allow comments on entries” daca dorim ca participantii care au permisiunea de a posta comentarii,
sa poatd comenta intrarile glosarului.

La ,,Automatically link glossary entries” precizam daca dorim ca orice aparitie in cadrul cursului a
termenilor din glosar sa aiba forma unui link catre explicatia asociata.

Appearance
La , Display format” alegem unul dintre cele 7 formate de afisare disponibile.

e Full with author” afiseaza ca linkuri datele autorului si fisierele atasate.

e Full without author” afiseaza fisierele atasate ca linkuri.

e Encyclopedia” listeaza inregistrarile una dupa alta, separate doar prin icoanele de editare.
e Entry list” este ca ,Full with author”, avand in plus si imaginile afisate in linie.

e ,Simple, dictionary style” nu afiseaza autorii, iar atasamentele apar sub forma de linkuri.

e ,FAQ” are cuvintele “INTREBARE” si "RASPUNS” anexate definitiilor conceptelor.
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Simple, dictionary style +

Continuous without author
Encyclopedia

Entry list

FAQ

Full with author

Full without author

Simple, dictionary style

»Show alphabet links” stabileste daca participantii pot parcurge glosarul in ordine alfabetica.

»Show 'ALL' link” stabileste daca vor putea fi rasfoite toate intrarile deodata.

~Show 'Special’ link” precizeaza daca se va putea parcurge glosarul dupa caractere speciale, cum ar fi
@ si #.

LAllow print view" stabileste daca li se afiseaza cursantilor un link (disponibil mereu instructorilor) spre
o versiune a glosarului care se poate tipari.

Ratings

in sectiunea ,Ratings” stabilim, asa cum am prezentat si la activititile anterioare, care sunt rolurile
care permit evaluarea intrarilor, cum are loc agregarea notelor pentru a obtine nota finala din catalog
si daca notarea se restrange la o anumita perioada de timp precizata.

Utilizare activitate ,Glossary”

Atunci cand accesam link-ul glosarului de pe pagina cursului, suntem condusi pe pagina glosarului, unde
putem adauga noi termeni, dupa apasarea butonului ,,Add a new entry”.

TIC -

£ Printer-friendly version

Tehnologia Informatiei si a Comunicatiilor

Search #Search full text

Add a new entry

Browse the glossary using this index

Special [A|B|C|D|E|FIGIH[I[JIKILIMIN|OIP|Q|RIS|TIUJVIW|X]|Y|Z]|ALL

No entries found in this section

Pe pagina de adaugare a unei noi intrari ni se cere sa scriem conceptul si definitia sa, cuvintele cheie
asociate, sa precizam daca dorim ca aparitiile acestui concept in curs sa devina link-uri catre definitia
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sa, daca tinem cont de tipul literelor (mari si mici) in cuvant si daca in curs se va semnala doar aparitia
cuvantului singur sau si cand este inclus in alte cuvinte.

Intrarile in glosar pot fi vizualizate alfabetic, doar o anumita litera sau toate la un loc.

Lesson

Lectia creatd de profesor constd intr-un numér de pagini pe care trebuie s le parcurgd cursantul. Tn
general, la baza fiecdrei pagini se afld o intrebare. Tn functia de corectitudinea raspunsului oferit,
cursantul este condus la pagina urmatoare sau intors la o pagind anterioara.

Setari activitate Lesson

Pe pagina de adaugare a unei lectii, in sectiunea General completdm numele si o scurtd descriere a
lectiei.

Appearance

,Display ongoing score” produce afisarea pe fiecare pagina a punctajului total obtinut de cursant pana
in acel moment.

,Maximum numbers of answers” reprezinta numarul maxim de variante de raspuns care se pot gasi pe
paginile lectiei.

Availability

Activand , Available from” si ,,Deadline”, putem preciza datele calendaristice intre care este disponibila
lectia.

Daca activam , Time limit”, atunci aici precizam Tn cate minute trebuie parcursa lectia de catre cursanti.
Cursantul poate sa depaseasca acest timp limita, dar raspunsurile oferite cu intarziere nu mai sunt luate
in considerare la determinarea notei.

Flow control
n sectiunea ,,Flow control” putem preciza:

- LAllow student review” —optiunea ,,Yes” daca dorim ca pe ultima pagina a cursului sa fie prezent
un buton care sa permita reluarea lectiei de catre cursant;

- ,Provide option to try a question again” — optiunea ,Yes” pentru aparitia unui buton dupa
oferirea unui raspuns gresit la o intrebare. Cursantul poate alege sa raspunda din nou, fara a fi
punctat, sau sa continue lectia;

- ,Maximum number of attempts” — care sa fie numarul maxim de incercari permise pentru
fiecare intrebare. La atingerea acestui maxim, cursantul va fi automat condus la pagina
urmatoare;
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Grade
La ,,Practice lesson” stabilim daca este doar o lectie de antrenament, care nu se trece in catalog.

,Custom scoring” permite ca fiecarui raspuns sad i se poatd acorda o valoare numerica, pozitiva sau
negativa, in scopuri de evaluare.

Daca Retaks-alowed are valoarea ,, Yes”, cursantii vor putea parcurge de mai multe ori lectia.

Daca permitem cursantilor sa acceseze de mai multe ori lectia, stabilim in ,Handling of re-takes” cum
le acordam nota (ca o medie sau ca un maxim al tuturor incercarilor).

Utilizare activitate Lesson

Dupa salvarea lectiei, aceasta va aparea sub forma de link pe pagina cursului. La accesarea linkului nou
creat, suntem condusi catre o pagina de initiere a editarii continutului lectiei. Pagina are 4 tab-uri:
,Preview”, Edit”, ,Reports” si ,Grade essays” dintre care primele doua sunt cele mai folosite.

Relatii intre tabele

Preview Edit Reports Grade essays

Collapsed Expanded

What would you like to do first?
mport questions

Add a content page

Add a cluster

Add a question page

Lectia este alcatuita din pagini. Studentul interactioneaza cu doua tipuri de pagini: ,Content page” si
»Question page”. Primul tip, pe langa alt continut, poate furniza linkuri spre alte pagini, semanand cu
un cuprins. Nu are niciun efect asupra notei. Al doilea tip are titlu, continut si o intrebare la baza paginii.
n functie de corectitudinea raspunsului oferit, studentul este condus spre o noud pagina.

Relatii intre tabele -

Preview Edit Reports Grade essays

Tipuri de relatii

O haza de date proiectata corect nu are date redundante (dubluri). De exemplu nu vom memora in aceeasi tabela datele personale ale clientului si comenzile sale pentru ca atunci
datele personale s-ar putea repeta la fiecare comanda a unui client. Solutia este sa impartim datele in mai multe tabele (in cazul nostru, una cu informatii despre client si alta
referitoare la comenzi), apoi sa stabilim relatii intre acestea.

Relatia asociaza un camp (in majoritatea cazurilor, cheie primara) al unui tabel cu un camp (cheie externa) al altui tabel. Acesta campuri nu trebuie sa aiba neaparat acelasi nume, ci
doar acelasi tip de data (cu exceptia cazului cand cheia prmara este de tip AutonUmber)

Unu la unu Unu la mai multe Mai multe la mai multe
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Relatii intre tabele

Preview Edit Reports Grade essays

Collapsed Expanded

mport questions | Add a content page | Add a cluster | Add a question page here
Unulaunu | & [0 @ @

Unu-la-unu, cand unei linii din primul tabel i se asociaza o singura linie in al doilea tabel si invers. Rar sunt intalnite, deacarece
informatiile s-ar putea stoca intr-un singur tabel. Se pot utiliza atunci cand, datorita numarului prea mare de campuri, tabelul se
divizeaza, cand o parte a campurilor trebuie pastrata separat din motive de securitate, sau cand unele informatii se regasesc doar
intr-un subset al tabelului.

Cand este nevoie de o relatie unu la unu?

Multichoice
ATEE Cand, datorita numarului prea mare de campuri, tabelul se divizeaza.
Raspuns corect!

Response 1:

Score: 1
Jump:  Next page
Cand campurile trebuie pastrate separat din motive de securitate.

Answer 2:

Response 2 Raspuns gresit!

Se obisnuieste ca primul raspuns sa fie cel corect, iar urmatoarele gresite. Atunci cand cursantul
parcurge lectia, aceste alegeri apar intr-o ordine aleatoare. De multe ori, cdnd cream o pagina, nu
putem stabili corect la ce pagina dorim sa realizam saltul, deoarece acea paginad nu a fost creata si
salvatd si astfel nu apare in lista derulantd spre a putea fi aleasd. n acest caz, facem o alt3 alegere,
salvam pagina si reluam editarea ei dupa ce pagina dorita a fost creata.

Quiz
Testul reprezinta o unitate logica de activitate pe platforma, poate cea mai importanta unitate pentru
notarea cunostintelor studentilor in mod obiectiv.

Testul trebuie privit sau inteles ca o unitate structurata de itemi, de acelasi mod de prezentare pe ecran
sau de prezentare eterogena, prin care se urmareste evaluarea sau autoevaluarea unui volum de
cunostinte sau abilitati. Din perspectiva platformelor de e-learning, testul este un formular care
permite gestionarea usoara a parametrilor de aplicare cum ar fi numarul de itemi, modul de extragere
a itemilor, felul interactiv sau nu, timpul total de lucru, cadenta intrebarilor, dreptul de revenire sau nu
asupra raspunsurilor, aplicarea sau nu a penalitatilor, valoarea penalitatilor aplicate, rularea testului
de mai multe ori, intervalul minim de timp dintre doua rulari, momentul activarii, momentul opririi,
etc.

Crearea testului se face in interiorul cursului de care apartine. Se activeaza , Turn editing on” prin, iar
din lista de activitati se alege , Quiz”.

Setari activitate Quiz
Ca urmarea acestei solicitari sistemul deschide o fereastra noua care reprezinta formularul de
configurare a viitorului test. Parametrii pot fi setati oricum pentru ca se permite revenirea in modul
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editare chiar si dupa popularea testului cu intrebari. Restrictii pot sa intervina abia dupa ce testul a fost
rulat de un grup de cursanti.

n sectiunea General se completeazd numele si descrierea activititii de test respective.
Timing

Tn sectiunea , Timing” se seteazd parametrii ce tin de data de pornire, data de oprire si durata testului.
De asemenea existda campuri destinate setarii comportamentului testului odata ce timpul limita a
expirat precum si campul de setare a timpului limita pana cand un test poate fi trimis. Acest ultim camp
este valabil numai in cazul in care pentru ,When time expires” a fost setat , There is a grace period...”.

Grade

Cand se permite rezolvarea testului de mai multe ori, exista mai multe variante de calcul a notei finale.
Astfel se alege dintre urmatoarele variante:

e Highest grade” - incercarea cu cea mai buna nota stabileste nota finala.

e ,Average grade” - nota finala este calculata astfel: se face media notelor de la toate incercarile.

e First grade” - nota finala este cea obtinuta la prima incercare de rezolvare a testului (celelalte
incercari sunt ignorate).

e lastgrade” - nota finala este cea obtinuta la ultima Tncercare de rezolvare a testului (celelalte
fncercari sunt ignorate).

Question behaviour

Daca se activeaza ,Shuffle within questions”, atunci de fiecare data cand studentul va accesa testul
intrebarile cu variante de raspuns si intrebarile cu elemente de potrivit, componentele acestora vor fi
amestecate la intamplare.

Review options
Sectiunea ,Review options” reprezinta un set de optiuni pentru vizualizarea rezultatelor si feedback.
Extra restrictions on attempts

Sectiunea ,,Extra restrictions on attempts” contine campuri pentru setarea unei parole de accesare a
testului, pentru a restrictiona adresa IP a dispozitivului de unde se poate rula testul, cAmpuri pentru
setarea intervalului de timp intre prima incercare si a doua si setarea intervalelor de timp intre
incercarile ulterioare.

Overall feedback
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n sectiunea ,Overall feedback” se poate seta un text ce sd apard dupé finalizarea testului. Dacd se
completeaza Grade boundary (limite de punctaj), atunci feedbackul va fi afisat in functie de punctajul
obtinut.

Utilizare activitate Quiz

n interiorul testelor, dupd crearea testului prin setarea parametrilor de mai sus, in formularul anterior,
se poate face modificarea parametrilor, informatiilor generale despre test, vizualizarea continutului,
rezultatele obtinute de studenti, editari de continut, acces la categorii de intrebari, acces la intrebari,
export, import etc.

Continutul diversificat al testului este asigurat in principal de modul in care sunt create categoriile de
intrebari si de modul in care sunt apelate.

Evaluarea rezultatelor poate sa se faca prin retinerea punctajului minim, a punctajului maxim sau a
punctajului mediu.

Dupa ce s-a creat structura testului se trece la completarea cu intrebari prin activarea butonului de
editare , Edit quiz”.

Fvaluare

Grading method: Highest grade

No questions have been added yet X

Edit quiz

Back to the course

Urmatorul pas este popularea testului cu intrebdri. Intrebari noi, pot fi addugate in acel moment in
test. Acestea vor fi salvate automat intr-o categorie dintr-o baza de date a intrebarilor, pentru a putea
fi folosite si in alte teste din cadrul acelui curs.

intrebdrile deja existente, pot fi selectate din bazd de date cu intrebdri, ,Question bank”, si introduse
in lista intrebérilor efectiv utilizate in derularea testului. Intr-un test pot s& fie incluse anumite intrebdri
pe care profesorul le doreste sa existe in mod explicit si altele pe care le extrage sistemul in mod
aleatoriu dintr-o categorie sau din alta.

Intrebérile la randul lor pot avea réspunsurile in ordinea n care au fost editate sau in ordine aleatorie
si care se schimba la fiecare prezentare.
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Editing quiz: Test de verificare pentru tipuri de intrebari @

Questions: 2 | Quiz open (closes 27/11/2015 09:33) Nota maximé: |10,00 _|Salveazd
= Total of marks: 2.00 Addugare
Repaginate| a new 4——""""—— intrebare noud
Permite mutarea intrebarii pe o alta pagina question
Pag‘ir‘m/sau schimbarea ordinii in aceiasi pagina from
L 4“1 % Random (Implicit pentru d3) (See questions) { + questiongg—rddugare intrebare din
™ Pagin 2 bank banca de intrebari
ina
a
& 2 .« %4wefteygerdsgdfg € 4 randon™P—ur__ . )
question Adaugare intrebare
~——er] din banca aleator
I
Add from the guestion bank to page 0 [ %

Selectarea categoriei din care

Select a category’ Implicit pentru d3 (7) v | —— ‘ e nt
ace parte intrebarea

Categoria implicitd pentru intrebarile partajate in contextul 'd3".
Search options p
T~ intrebare
+ LR
+¢ - 1 Er s
4 o S
+‘¢ (] r = e
+ .n -

“e P

PP PLL LHLP

Add selected questions to the quizi® Adaugi la test intrebérile selectate

d

,BJTCHJ plus adauga la test intrebarea corespunzatoare

Pentru ca sa se poata exploata bine flexibilitatea de construire a testelor, trebuie in mod obligatoriu ca
intrebarile sa fie construite pe categorii, structurate pe capitole si pe tip de intrebare. Organizarea
intrebarilor pe categorii si subcategorii este esentiala daca se lucreaza cu pachete mari de intrebari
pentru ca o categorie de intrebari de rang superior poate apela intrebarile din toate subcategoriile pe
care le include pentru realizarea unui test dat.

Construirea categoriilor de Intrebari

O categorie de intrebari apartine de regula unui curs. Existd posibilitatea mostenirii daca pentru
acestea s-a setat atributul public sau daca sunt atasate unui curs care face parte la randul lui dintr-un
meta curs. Modul de structurare pe categorii, respectiv subcategorii depinde in exclusivitate de
administratorul de curs. Cand sunt multe intrebari exista riscul ca, in cazul in care intrebarile nu sunt
organizate foarte bine, sa apara intr-un test aceeasi intrebare de mai multe ori.
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Se selecteaza prima datd cursul de care va apartine categoria, apoi din meniul ,Actions Menu” >
»More...” se deschide pagina , Course administration”. Aici vom selecta sectiunea , Question bank” >
,Categories”.

Pentru fiecare curs existd categoria implicitd (default) a cursului. incepétorii in activitatea pe platforma
obisnuiesc sa foloseasca exclusiv aceasta categorie fapt care ulterior poate avea implicatii nedorite mai
ales n situatia in care acel bloc este partajat intre mai multi profesori. Se creeaza astfel posibilitatea
de interferenta pentru teste.

Se alege categoria parinte pentru categoria pe care dorim sa o cream. Daca sunt multe categorii
implementate trebuie sa derulam pana la sfarsitul listei. Se editeaza numele categoriei eventual se
editeaza si informatii explicative in ,Category info”, dupa care se selecteaza butonul ,,Add category”.

Tipuri de intrebari
Multiple choice

Se propune un set de raspunsuri. Prin selectarea campurilor de validare se aleg unul sau mai multe
raspunsuri. Editarea intrebarii este similara cu celelalte iar alocarea punctajului la construirea intrebarii
este ilustrata mai jos. Nu uitati pentru multiple raspunsuri corecte alocarea punctajului se face in asa
fel Tncat suma punctajelor sa fie punctajul maxim. Aceasta intrebare poate fi setd sa aiba un singur
réspuns corect. in cazul acesta rdspunsul corect va avea punctajul maxim, iar celelalte variante de
raspuns 0.

Select one:
a. A hashtag
® b.Atag
c. A tweet

S

Clear n@m ce
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One or multiple answers?

Number the choices?

= Answers

Choice 1

Grade

Feedback

Choice 2

Grade

Feedback

Choice 3

Grade

True / False
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Multiple answers allowed +

¢ Shuffle the choices? @

a,h,c =
1 A~ B
iesire
50% +
1 A~ B
1 A~ B
intrare
50% *
1 A~ B
1 A~ B

nu este periferic

-100% *

HOLISUN

.
=
=

fr
a=

.
=

Pentru acest tip de intrebare se alege prin buton radio daca enuntul este adevarat sau fals.

~ General
Categorie
Question name™
Question text*

Default mark*®
General feedback @

Raspuns corect

Feedback la selectarea
raspunsului "Adevarat".

Feedback la selectarea
raspunsului "Fals".

Implicit pentru d3 (9)
Memorial

G Paragraf *~ B

I

Memoria RAM este o memorie volatila

Titlul
intrebdrii

Enuntul intrebarii

Cale: p

1 M Punictajul obtinut

T Paragraf ~ BT =iz
Cale: p

Adevarat v

B | Paragraf ~ B I|*=|i=
Corect!

Cale: p

B rregaf ~| B ]| iZ|i=

Al gresit!

Cale: p

Page 7 8
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Matching

Acest tip de intrebare cere potrivirea raspunsurilor corecte din listele de raspunsuri posibile. Editarea
intrebarii este urmatoarea:

F owWigANINLCALE Wa

~ General
Categorie | Implicit pentru d3 (11) v
Question name* |Matching

Question text*

[ | Paragraf |§| Eﬂ 2
Default mark* [1
General feedback - P .
E5 | paragef | B | | 3i=i= [l | B |

Cale: p
shuffle @ P Dacéd se activeazd, ordinea declaratiilor {réspunsurilor) este amestecatd la intamplar
pentru fiecare intrebare, cu conditia ca "Amestecare in intrebari” din setdrile testului
~ . sa fie, de asemenea, activata.
v Raspunsurl
Available Trebuie sa specificali cel putin doua intrebari si trei raspunsuri. Puteti introduce raspunsuri gresite
choices suplimentare furnizand un raspuns la o intrebare "inexistenta” (in blanc). Perechile intrebare-raspuns
unde ambele campuri au fost Iasate necompletate nu vor fi luate in considerare.

Question 1 — 1= -
&5 Paragraf *- B I =|i= MSRC
tastatura
Cale: p

Raspuns intrare

Question 2 — =
& Paragraf - B I == b B &
monitor
Cale: p

Raspuns iesire

Question 3 — -
D Paragraf b B I =iz E‘ 3

hard-disk

Short answer

Raspunsul este un text scurt. Poate fi cu litere mari sau nu dupa cum considera profesorul sau pot fi
cifre.

Page 7 9
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Adding a short answer question @
b Maximize
~ General
Categorie | Implicit pentru d3 (15) il
Question name™ Q2
Question text™

B || gt || B| ] |2 i o | BF | ®
Un fisier html incepe cu tagul
Cale: p
Default mark™ 1
General feedback > = ==
) 5 Paragraf yIB| I |::=i= (Aef | BYE 2]
Cale: p

Case sensitivity No, case is unimportant v

Correct answers Trebuie sa furnizati cel putin un raspuns posibil. Raspunsurile necompletate nu vor fi utilizate. ™
poate fi utilizat ca wildcard pentru toate caracterele. Primul raspuns gasit care corespunde va fi
utilizat pentru determinarea notei sau a feedback-ului.

v Raspunsuri

Raspuns 1 him! Nota | 100% v

Feedback - S (" Lo
G5 | paragraf v || B | ] | i iZ a PR
Cale: p

Raspuns 2 phody Nota | Niciunul v

Feedback

== || Paranraf - R I o= |22 PO Y-

Numerical

Acest tip de intrebare asteapta ca raspuns o valoare numerica. Se preteaza foarte bine pentru
disciplinele abstracte pentru verificarea rapida a unor probleme care presupun calcule. Raspunsul
corect poate fiin limita unei abateri precizate prin eroarea inscrisa la editare.

~ Raspunsuri

Raspuns 1
15 Error [1 Notad | 100% v
Feedback
Paragraf ~ B[] =|i= ad | B8 | &y
Cale: p
Raspuns 2
Error 0 Nota | Niciunul v
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Essay

La acest tip de intrebare raspunsul este un text pe care cursantul il editeaza iar examinatorul il noteaza.
Sistemul nu poate face evaluare in mod automat. Pentru evaluare profesorul trebuie sa intervina sa
citeasca raspunsul dat de cursant si sa noteze in mod clasic. Fereastra de editare a intrebari este
urmatoarea:

Adding an Essay question @

+ General
Categorie | Implicit pentru d3 (10) v
Question name™ |Eseu

Question text™®

g
rrx

Paragraf vy B!l T ||:=:= Al

Default mark™ |1

General feedback

o
XX

Paragraf vI|B| I |l:=:= Al

Cale: p

~ Response Options

Response format | HTML editor v

introducere

tura este

Require text | Require the student to enter text v

Input box size |15 lines Y ¥ Nr. de li
Allow |1 -
attachments

Require | Attachments are optional v
attachments

@

Daca atasamentele sunt obli

sau nu.

Calculated

intrebarile de tip calculat permit verificarea corectitudinii efectudrii calculelor de cétre cei testati in
mod individual pentru una si aceeasi expresie. Sunt deosebit de utile pentru disciplinele matematica,
fizica, tehnologii de diferite profiluri. Expresia propusa pentru rezolvare poate fi editata in corpul
intrebarii. Dupa editarea intrebarii de tip calculat sistemul propune fiecarei persoane testate un set de
valori din domeniul de definitie al expresiei propuse si asteapta introducerea de catre cel testat a valorii
de raspuns corecte.

n expresii se acceptd operatorii +, -, *, /, si %, acesta din urma fiind operatorul modulo. Se mai accepts
24 de functii predefinite, de un singur argument si anume: abs, acos, acosh, asin, asinh, atan, atanh,
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ceil, cos, cosh, deg2rad, exp, expm1, floor, log, log10, loglp, rad2deg, round, sin, sinh, sqrt, tan, tanh
si doua functii de doua argumente: atan2 si pow. Se mai pot folosi si functiile min si max, de doua sau
mai multe argumente.

La redactarea unei expresii, meta caracterele (notatiile literare din expresii) se vor insera intre
paranteze de tip acolada {}, iar pentru argumentul functiei daca se foloseste o functie predefinita se
foloseste tipul de paranteze (). Valoarea raspunsului asteptat poate sa aiba o abatere de la valoarea
exactd. Campul tolerantd permite celui care a propus intrebarea si hotirascd marja de eroare. In
functie de situatia concreta tipul si valoarea tolerantei trebuie alese cu mare atentie.

Toleranta acceptata pentru rezultat poate fi de trei tipuri: relativa, nominala si geometrica:

e toleranta relativa - de exemplu 0,25 se accepta rezultate cu valoarea cuprinsa intre valorile +,-
valoarea nominala*25%

e toleranta nominala — de exemplu daca este 10, se accepta rezultate cu valoarea intre: valoarea
nominala -10 si valoarea nominala +10;

e toleranta geometrica - de exemplu daca este 0.5 se accepta rezultate cu valoarea cuprinsa intre
valorile: valoarea nominald/(1+0,5) si valoarea nominala*(1+05).

Tn momentul editdrii intrebdrii sistemul creeazs tabele de valori asociate pentru variabilele care intra
in expresia de calcul editata. Aceste tabele pot sa fie partajate cu alte intrebari sau pot sa fie
individuale. Pentru a nu exista interferente nedorite sau astfel spus necontrolabile ale domeniilor de
definitie, pentru intrebari s-a folosit numai varianta cu tabel propriu, pentru fiecare intrebare si meta
caracter. Partajarea tabelelor de valori poate conduce la rezultate neasteptate dar aparent conforme
Cu expresia matematica.

Daca se aloca in anumite situatii mai multe raspunsuri corecte atunci suma procentuala a raspunsurilor
trebuie sa fie 100%.
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Adding a Calculated question @

~ General
Categorie | Implicit pentru d3 (7) v
Actualizeaza categorial
Shared wild cards No shared wild card in this category

Question name* |Calculat S Titlul intrebérii
Question text*

B | Pmgf v B ] ||[iZ]i= ad | BF | ™
Caleulati expresia E=a+b -
Enuntul —|
pentry a = {a} sib = {b} =
Cale:p 2
Default mark™ |1 Ar——Punctajul
General feedback . -
© [ reor ~|[B|7[=]iz S
Cale: p
~ Raspunsuri / Expresia raspunsului corect
Answer 1 formula = a14/h) | Notd | 100% v
Maloarea Tolerance * g1 Type | Relative -\
: i Tipul tolerantei
tolerantEI/nsmrdlsplay 2 v | Format | decimals v
Feedback i
. _ & mwet v B |iZ|iS I
Numarul de zecimale
Feedback daca gste cazul -
Cale: p e
|Blanks for 1 more answers
» Unit handling
« Units Unitati de masura dacé este necesar
unit1 @ | | Multiplier [1.0

Blanks for 2 more units|

Drag and drop onto text

Un tip de intrebare in care tragem cu mouse-ul dintr-o listd, cuvintele lipsa dintr-un paragraf.

Complete the sentences by using the correct words from the list

John Wkes :' football with |:| frends
Jane also en}? to matches with D friends and they often [:, out

together with families

’p&aﬁ.m;" go ” play ” g-:m-;]éD
i
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Addugatiintrebarea in editorul de text, folosind orice formatare doriti. Folositi paranteze patrate duble
»[[n]]” cu un numar in locul cuvantului pe care doriti sa il gdseasca cursantii:

glurBl1][=i=]le 2 BB

Drag the words from the list below into the correct spaces:

When something or someone is the subject of a sentence, it is in the [[1]] case.
When something or someone is the object of a sentence, it is the [[2]] case.
When we talk about ownership, we use the [[3]] case.

The indirect object is known as the [[4]] case.

Adaugati cuvintele sau frazele care lipsesc in campurile numerotate corect, in sectiunea ,,Choice”.
(Puteti adauga mai multe cuvinte pentru a ingreuna alegerea celor corecte.)

Shuffle
Choice 1 ppewer Nominative Group 1 ¥ Unitmited
Choice 2 angwer accusative Group 1 ¥ Unlimited
Cholce 3  answer genitive Group 1 7 Unlimited
Choice 4 ppngyer dative Group 1 Y Unkimited
Choice 5 ancwer Group 1 ¥ Unlimited
Choice 8  Ancwer Group 1 * Unlimited
Choice 7 answer Group 1 Y Undimited

Blanks for 3 more choices

Select missing words

Este foarte asemanatoare cu intrebarea ,Drag and drop onto text”, dar foloseste meniuri drop-down
in loc de casete pentru drag-and-drop.
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Choose the right words for the right gaps:

When something or someone is the subject of a sentence, it is in the Choose... v
case.

When something or someone is the object of a sentence, it is the Choose... ¥ case.
When we talk about ownership, we use the Choose... r case.

The indirect object is known as the| Choose... ¥ |case.

Choose. ..
nominative

genitive
accusative

Punctajul intrebarilor si a testului
Tn mod implicit o intrebare este punctatd cu valoarea 1 punct. Evident c& cel care creeaza intrebarea
poate sa aloce un alt puncta;j.

Din aceasta valoare unele intrebari aloca procente partiale in functie de raspuns de exemplu intrebarea
de tip adevarat sau fals 100% sau 0%, iar altele la care exista mai multe raspunsuri adevarate la
intrebare un procent proportional, cu cate raspunsuri corecte are intrebarea si la cate a raspuns,
procent calculat din valoarea totala acordata intrebarii. Suma procentelor pozitive pentru fiecare
intrebare este obligatoriu 100%.

Se pot atribui si procente negative pentru raspunsurile gresite pentru-ca in felul acesta se sanctioneaza
studentii care completeaza raspunsurile in mod neglijent si in viteza. A lasa raspunsurile gresite fara
punctaj negativ inseamna a permite completarea la intamplare, de genul, daca ghicesc bine daca nu,
nu se Intdmpld nimic. n plus completarea tuturor casetelor de validare conduce la un punctaj scizut

sau chiar nul.
| None M 5% :

100% -10%
90% S11.11111%
83.33333% 12.5%
80% -14.28571%
75% -16.66667%
70% -20%
66.66667% _259%
60% -30%
50% -33.33333%
40%
33.33333% -50%
30% -60%
25% -66.66667%
20% -70%
16.66667% -75%
14.28571% -80%
12.5% -83.33333%
11.11111% -90%
10% - -100%
None + None =
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Fata de aceste punctaje atribuite fiecarei intrebari, testul are factor de penalizare general de valoare
implicita 0.1, care se activeaza in situatia in care un student revine asupra unuia sau a altuia dintre
raspunsuri si face modificari. Factorul acesta de penalizare poate descuraja pe cei care sunt nesiguri in
completarea raspunsurilor. Acest factor poate fi setat la valori severe de depunctare in functie de
conditiile concrete de aplicare ale testului.

La sfarsitul testului cursantul vede ce rezultat a obtinut.

Summary of your previous attempts

Attempt State Grade / 20,00 Review Feedback

1 Finished 10,67 Review
Submitted miercuri, 15 aprilie 2020, 16:35

My Overall feedback

Good!

First attempt: 10,67 / 20,00.

Overall feedback
My Overall feedback

Good!

Re-attempt quiz

Feedback

Toate tipurile de intrebari accepta feedback pentru fiecare raspuns in situatia in care intrebarea
permite mai multe raspunsuri sau un feedback global referitor la intreaga intrebare. Acestea vor fi
afisate particularizat corelat cu modul in care a rdspuns fiecare cursant la fiecare intrebare. in plus
intregul test poate sa aiba un feedback care va fi afisat tuturor celor care au parcurs testul. Feedbackul
si rezultatele vor fi afisate in diferite momente hotarate de catre profesor conform cu setarile alese din
figura de mai jos.

~ Review options ¢

During the attempt immediately after the attempt Later, while the quiz is still open After the quiz is closed

The attempt © The attempt The attempt The attempt
@ Whether correct © Whether correct & Whether correct & Whether correct
@ Marks © Marks @ Marks @ Marks

Specific feedback

& General feedback

& Right answer ©
Overall feedback ©

Rezultate Quiz

Specific feedback
General feedback
8 Right answer

Overall feedback

@ Specific feedback
@ General feedback
@ Right answer

& Overall feedback

8 Specific feedback
General feedback
@ Right answer

@ Overall feedback

Pentru a vedea rezultatele sau rapoartele unui test precum si daca sunt eseuri care trebuie notate

manual, un profesor poate accesa meniul Actions Menu > Results din cadrul unui test.
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Wiki

,Wiki” permite crearea colectiva a documentelor, cu pastrarea unui istoric al tuturor modificarilor
efectuate. La un wiki poate lucra intreaga clasa sau un singur cursant, ajutat de profesor si colegi. Se
incepe cu o prima pagina, la care elevii pot adduga altele, creand legaturi catre noile pagini, care inca
nu exista. Pagina initiala poate fi conceputa ca un cuprins, cu linkuri catre alte pagini.

Este o metoda foarte rapida de creare a documentelor in grup. De obicei nu exista o persoana care sa
detina controlul editorial.

Setari activitate Wiki
Pe pagina de creare a unui ,, Wiki” tastam numele si o scurta descriere a acestuia.

Mai precizam numele primei pagini in , First page name”, selecta in campul ,, Wiki mode” daca dorim ca
acest wiki sa fie colaborativ (toata lumea il poate edita) sau individual (poate fi editat de catre o singura
persoana), formatul implicit (folosit la editarea paginilor wiki) si daca fortam formatul (nu se mai poate
alege formatul cand se editeaza o pagina wiki).

Utilizare activitate Wiki

Dupa operatia de salvare, noul wiki devine link pe pagina cursului. Cand un utilizator acceseaza link-ul,
este condus la o paginad in care vede descrierea activitatii wiki, numele paginii initiale, poate alege unul
dintre cele trei formate si apoi, apasand butonul , Create page”, initiaza crearea acesteia.

0 General overview

2]

® HTML format @

Pentru crearea unei pagini avem la dispozitie editorul HTML cunoscut. Putem adduga text, tabele,
imagini, putem formata textul. Daca dorim sa adaugam o pagina noud, credm intai un link catre ea,
scriind un text incadrat intre paranteze patrate duble. Apasand butonul ,,Save”, vom vizualiza pagina si
putem observa legaturile create.
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This wiki is to plan for our group project.
[[Roles]]
[[Tasks]]

[[Schedule]]

General overview

This wiki is to plan for our group project.
Roles

Tasks

Schedule

Daca efectuam click pe una dintre legaturile care tocmai au aparut in modul vizualizare, vom fi din nou
condusi catre o pagina unde se initiaza crearea unei pagini noi, care va fi asociate legaturii respective.
Titlul acesteia este textul pe care I-am incadrat inainte intre paranteze patrate duble. Editam si aceasta
pagina si apasam butonul ,Save”. Pentru revenirea la pagina initiala atunci cand vizualizam alta pagina,
apasam butonul ,Search wikis” din coltul din dreapta sus.

Workshop

Activitatea ,Workshop” este o activitate complexa, cu mare potential pedagogic, ce implica realizarea
unor teme si un cadru structurat de evaluare sau feedback. Profesorul precizeaza mai multe aspecte
ale sarcinii de lucru, care sunt evaluate separat si apoi combinate pentru obtinerea notei finale.
Cursantii nu trimit doare temele, ci participa la evaluarea acelora trimise de colegi, furnizand feedback,
sugestii si note. Aceasta modalitate de evaluare ofera cursantilor posibilitatea de a vedea alte teme si
de ainvata din ele si din feedback-urile oferite de ceilalti.

Pasii de baza in aceasta activitate sunt:

- profesorul stabileste tema de lucru, criteriile acesteia si strategia de notare;

- optional incarca exemple de teme bune si rele, pe care cursantii se antreneaza evaluandu-le;

- cursantii si elaboreaza si trimit temele. Ei au posibilitatea de a-si descirca tema de pe
platforma, a o reface si a o trimite din nou;

- optional cursantii isi evalueaza tema;

- optional cursantii primesc un numar stabilit de teme alese aleator, spre a le aprecia, comenta
si evalua. Notele lor pot fi suprascrise de catre profesor;

- optional profesorul evalueaza temele si calitatea aprecierilor facute de cursanti;

- se stabileste nota finald, prin combinarea notei pentru tema realizata cu aceea pentru
evaluarea facuta.

Atunci cand cursantii nu evalueaza si exista o singura strategie de notare, activitatea este similara cu

aceea numita ,Assignment”.
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Daca tema consta in trimiterea unui eseu si sunt foarte multi cursanti, profesorul poate verifica aleator
cateva evaluari realizate de acestia. El va fi atentionat asupra lucrarilor pentru care sunt diferente mari
de notare, caz in care va trebui sa stabileasca singur nota pentru lucrarea autorului si notele pentru
aprecierile facute de cursanti.

Atunci cand doreste sa obtina lucrari de o buna calitate, profesorul poate proceda astfel: in perioada
initiala permite doar comentarea temelor, nu si notarea lor. Pe baza comentariilor primite, cursantii Tsi
refac temele si le retrimit acelorasi evaluatori, spre notare. Procesul se poate relua pana la obtinerea
calitatii dorite a lucrarilor.

Setari activitate Workshop
n sectiunea General a paginii de adaugare a unui seminar, trebuie s3 precizim numele acestuia si o
scurta introducere a sa.

Grading settings
n sectiunea ,,Grading settings” putem preciza:

e Strategia de evaluare, prin valorile alese in lista derulanta ,Grading strategy”:

Accumulative grading =

Accumulative grading

Caomments
Mumber of errors
Rubric
o ,Accumulative grading”: Fiecare criteriu de evaluare are propriul punctaj numeric si o
ponderarea; o nota finala este calculata pe baza punctajelor criteriilor si a ponderilor
respective;
o ,Comments”: Fara nota numerica, doar feedback, sub forma de comentarii;
o ,Number of Errors”: Evaluatorii decid daca lucrarea bifeaza sau nu fiecare criteriu (de
exemplu, are idei originale; raspunde la intrebarea);
o ,Rubric”: Genereaza o nota numerica bazata pe nivelul de realizare ales de evaluatori
pentru fiecare criteriu.
e Nota maxima ce o pot obtine pentru tema trimisa, in ,,Grade for submission”;
e Nota maxima ce o pot obtine pentru evaluarile facute, in ,Grade for Assessment”;

Submission settings

in sectiunea ,Submission settings” se pot stabili instructiuni si cerinte pentru lucrdrile ce trebuie
trimise, numarul maxim de fisiere care pot fi incarcate si dimensiunea limita a acestora. Bifarea , Late
submissions” va permite cursantilor sa trimita o lucrare, dupa expirarea termenului. Orice trimitere
tardiva nu mai poate fi modificata de cursant - au doar o sansa de a o depune.
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Assessment settings

Tn sectiunea ,Assessment settings” putem preciza cateva instructiuni cu privire la evaluare. Aceste
instructiuni sunt importante pentru cursanti ca sa inteleaga mai bine cum sa evalueze munca colegilor.

Bifand , Use self-assessment” cursantul poate primi spre evaluarea propria sa tema.
Example submissions

Bifand ,,Use examples” furnizam exemple de teme care o sa-i ajute pe cursanti sa inteleaga mai bine ce
trebuie sa trimita si pot exersa evaluarea pe aceste exemple. Daca oferiti o lucrare ca exemplu, puteti
alege daca cursantii trebuie sa o evalueze sau daca este optional. Daca li se solicita sa evalueze
exemplele de lucrari, atunci puteti decide, de asemenea, daca le evalueaza inainte de a-si depune
propriile lucrari sau ulterior, dar Thainte de evaluarea lucrarilor colegilor.

Utilizare activitate Workshop

Dupa salvare, seminarul se regaseste sub forma de link pe pagina cursului. Dacd urmam acest link,
suntem condusi pe pagina seminarului, unde vedem, in afard de cerintd, etapa la care suntem in
aceasta activitate.

Fauna Muntilor Carpati -

Setup phase

Setup phase

. Switch to the submission phaseo Switch to the assessment phaseo Switch to the evaluation phaseo Close workshopo
Current phase

Sat the workshop I

description
Provide instructions for
submission

Edit assessment form

Switch to the next phase

Description

Lorem ipsum dolor sit amet, consectetur adipiscing elit.

Setup phase

Se observa primele doua etape au fost parcurse, fiind bifate, iar acum trebuie sa precizam cum dorim
ca cursantii sa evalueze temele colegilor lor. Pentru aceasta urmam link-ul ,Edit assessment form”, care
ne conduce la pagina ,,Accumulative grading”. Aici putem completa toate criteriile de care trebuie sa
se tind cont la evaluare, precum si punctajul si ponderea acordate fiecaruia.

Page9 0
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b Expand all

1 A B I = o N B WY WA o

Primul aspect:

Type Point %

Maximum grade

10

Dupa acest pas, apare bifata si etapa ,Edit assessment form”. Profesorul va trebui sa selecteze link-ul
»Switch to the next phase” pentru a da startul fazei urmatoare: ,,Submission phase”.
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Fauna Muntilor Carpati -
Submission phase

Setup phase Submission phase Assessment phase Grading evaluation phase Closed
Switch to the setup phaseO ® Switch to the assessment phaseD  Switch to the evaluation phaseQ)  Close workshop O
Current phase

Provide instructions for
assessment
=~ Allocate submissions
expectad: 2
submitted: 0
to allocate 0
@ There is at least one
author who has not yet
submitted their work

= Switch to the next phase

Instructions for submission ~

Proin faucibus, nisi sit amet blandit aliquam, odio massa cursus diam, convallis facilisis tortor velit vel dolor. Nulla in nulla eleifend, auctor
ligula non, tincidunt dui. Nunc neque ante, euismod sit amet mauris vel, mollis laoreet nulla.

Workshop submissions report «
Submitted (0) / not submitted (2)

Firstname ® « /Surname « Submission * « /Last modified * «

Student Doi No submission found for this user

. Mo submission found for this user
lonica lenescu

Showing 10 items per page = Change .. %

Submission phase

Studentul poate accesa acum linkul ,Submit your work” pentru a trimite fisierul cu tema lucrata. Este

condus catre o pagina pe care sunt afisare instructiunile pentru trimitere, completate de catre profesor
in etapa de creare a seminarului.

De indata ce un utilizator a trimis o lucrare, profesorul poate accesa link-ul ,,Allocate submissions”
pentru a stabili cum utilizatorii vor primi munca colegiilor pentru evaluare.

Manual allocation Random allocation Scheduled allocation

¥ Allocation settings
Group mode Nao groups

Number of reviews

.

5 % per submission *
Remave current allocations

Participants can assess without having submitted anything

Add self-assessments Self-assessment disabled

Save changes Cancel

Page9 2
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e ,Manual Allocation”: Aici, un profesor poate sa aleaga manual care cursanti vor evalua lucrarea
cui. Un cursant poate revizui lucrarile chiar daca nu a trimis inca.
e ,Random Allocation”

o Number of reviews: Aici, profesorul alege intre 0 si 30 de evaluari pentru fiecare lucrare
sau pentru fiecare evaluator. Adica profesorul poate alege sa stabileasca numarul de
evaludri pe care trebuie sa le aiba fiecare lucrare sau numarul de evaluari pe care trebuie
sa le efectueze fiecare cursant;

o Prevent reviews by peers from the same group: Daca profesorul doreste ca membrii din
acelasi grup sa nu-si revizuiasca niciodata munca reciproca;

o Remove current allocations: Bifand aceastda optiune Tnseamnad cd toate alocarile
manuale setate ih meniul ,,Manual Allocation” vor fi eliminate;

o Can access with no submission: Permite cursantilor sa evalueze munca celorlalti
cursanti, chiar daca nu si-au trimis propriile lucrari;

o Add self assessments: Cursatii trebuie sa-si evalueze propria munca pe langa cea a
colegilor;

e Scheduled Allocation”: Platforma va aloca automat (aleatoriu) lucrarile care vor fi evaluate
odata ce deadline-ul pentru trimiterea lucrarilor a trecut.

Profesorul trebuie sa selecteze ,Switch to the next phase” pentru a trece la urmatoarea faza:
»Assessment phase”.

! : -
Fauna Muntilor Carpati

Assessment phase

Assessment phase

Current phase . Switch to the evaluation phaseo Close workshopo

Switch to the setup phaseo Switch to the submission phaseo

Switch to the next phase

Workshop grades report

Firstname ® « /Surname » Submission® « /Last modified * « Grades received Grades given
e Doi - ()= onica lonescu - ()= lonica lonescu
Sl maodified on Wednesday, 15 April 2020, 2:16 AM
lonica lonescu onescu -(-)<  Student Do - ()= Student Doi
e modified an Wednesday, 15 April 2020, 2:10 AM

Showing 10 items per page = Change .. =

Assessment phase
o

Cursantii pot evalua exemple de teme pentru a exersa evaluarea, Thainte de a evalua activitatea Q)
. v . . v

colegilor lor, doar daca aceasta caracteristica este activata. Isi pot compara evaluarile cu evaluarile de 0
[a W
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referinta facute de profesor. Unui cursant i se va aloca un anumit numar de teme de la colegii sdi pentru
a le evalua. El va primi o nota pentru fiecare evaluare facuta, care va fi adaugata la nota pentru propria
lucrare trimisa si i se va calcula nota finala de la aceasta activitate. Unui student i se poate aloca propria
lucrare pentru a se autoevalua. Nota pe care o primeste la autoevaluare va fi luata in considerare
pentru la nota finala.

Dupa ce se finalizeaza evaluarea intre cursanti, profesorul va da startul noii faze: ,, Grading evaluation
phase”.

Compunere libera
Grading evaluation phase

Grading evaluation
Switch to the setup phase(O) Switch ta the submission phase(0)  Switch to the assessment phase(J) Close workshop (O

phase

Current phase @

Calculate submission

grades
expectedt 2
calculstec: O

Calculate assessment

grades
expected 2
calculated: 0

Provide a conclusion of
the activity
Switch to the next phase

Grading evaluation method Comparison with the best assessment

Grading evaluation settings

Comparison of )
fair +

Re-calculate grades

assessments

Grading evaluation phase

Obiectivul principal din aceasta faza este calcularea automata de catre platforma a notelor finale
pentru lucrarea trimisa si respectiv pentru evaluare. Profesorul poate edita aceste note cat timp se afla
Tn aceasta faza. Aceste note vor fi salvate in catalog doar in momentul inchiderii activitatii in faza finala.
Retineti ca este posibil sa va deplasati intre faze chiar si dupa ce actiunea a fost inchisa, notele mai pot
fi modificate direct in catalog, daca este necesar.

Grade calculation method: determind modul de calculare a notelor pentru evaludrile facute. in prezent,
exista o singura optiune — ,,Comparison with the best assessment”. Aceasta optiune incearca sa-si
imagineze cum ar arata o evaluare ipotetica, absolut corecta.
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Grading evaluation senings
Comparizon of assessments | fgip w
vy |
|5 i
strict
very strict

Re-calculate grades

,Comparison of assessments”: Exista 5 optiuni ,very lax”, ,lax”, ,fair”, ,strict” si ,very strict”. Aceste
optiuni exprima cat de stricta ar trebui sa fie comparatia evaluarilor. Prin ,Comparison with the best
assessment”, toate evaluarile vor fi comparate cu cea mai buna evaluare preluata de platforma. Cu cat
o evaluare este mai apropiata de cea mai buna evaluare, cu atat aceasta evaluare va primi o nota mai
mare. Aceasta setare determina, mai exact, gradul de scadere a notelor atunci cand evaluarile difera
de cea mai buna evaluare. Daca nu sunteti siguri de ce optiune sa alegeti, |asati valoarea implicita , fair”

,Grade for submission”: Nota finala pentru fiecare lucrare trimisa de cursanti, este calculata ca media
ponderata a notelor de evaluare particulare date de toti evaluatorii acelei lucrari. Profesorul poate
influenta aceasta nota in doua moduri: prin furnizarea propriei evaluari, eventual cu o pondere mai
mare setata, decat au ceilalti evaluatorii; prin suprascrierea notei la o valoare fixa.

»,Grade for assessment”: Nota pentru evaluare incearca sa estimeze calitatea evaludrilor pe care un
cursant le-a dat colegilor. Este calculata print-un algoritm de inteligenta artificiala al platformei.
Platforma alege una dintre evaluari ca fiind cea mai buna - cea mai apropiata de media tuturor
evaluarilor - si li confera o nota de 100%. Apoi, calculeaza , distanta” tuturor celorlalte evaluari fata de
aceasta, cea mai buna, si le da note mai mici in functie de cat de diferite sunt de cea mai buna evaluare
(avand in vedere ca cea mai buna reprezinta un consens al majoritatii evaluatorilor). Daca exista doar
doud evaludri pe o lucrare, platforma nu poate decide care dintre ele este cea ,,corectd”. Tn acest caz
profesorul poate trimite propria evaluare a lucrarii, sau poate seta o pondere mai mare la evaluarea
cursantului in care are mai mare incredere. Retineti ca nu sunt comparate notele finale a fiecarei

evaluari facute de cursanti, ci mai degraba punctajele si feedbackul criteriilor de evaluare.
inchiderea activitdtii Workshop

Cand sunteti multumit de nota finala, faceti click pe iconita sau textul pentru a inchide atelierul. Faza
,Closed” va fi evidentiata, iar cursantii isi vor putea vedea notele si o concluzie, daca ati adaugat una.

Grupuri de utilizatori

Utilizarea Grupurilor la nivel de context

Un grup sau o grupare pot fi utilizate la nivel de 2 contexte:
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- Groups
Group mode No groups s
Force group mode No %
Default grouping None #

Nivel de curs — Modul de grup definit la nivelul cursului este modul implicit pentru toate
activitatile definite Tn cadrul cursului respectiv. Pentru a putea utiliza un grup trebuie sa setati
in setdrile cursului ,,Group mode”: Actions Menu > Edit settings > Groups.

Nivel de activitate de curs — Fiecare activitate care accepta grupuri poate avea, de asemenea,
definit propriul mod de grup. Daca setarea cursului ,,Force group mode” este setata pe , Yes”,
optiunea de a defini un alt modul de grup pentru activitati individuale, nu este disponibila. Daca
este setat pe ,,No”, atunci profesorul poate schimba modul de grup.

Group Mode

Exista 3 moduri de grup:

»No groups” — Nu exista grupuri, toata lumea face parte dintr-o comunitate;

»,Separate groups” — Fiecare grup isi poate vedea propriul grup, ceilalti sunt invizibili.

,Visible groups” - Fiecare grup lucreaza in propriul grup, dar poate vedea si alte grupuri.
(Lucrarile celorlalte grupuri sunt numai in citire.)

Crearea unui grup

1.

N o

vk LN

n cadrul unui curs accesati sectiunea , Participants”, de unde selectati Actions Menu > Groups
> Create Group.

Selectati grupului un nume si optional o descriere, o cheie de inregistrare si o imagine.

Bifati ,,Enable group messaging” daca doriti sa activati conversatiile la nivel de grup.

Salvati.

Selectati grupul la care doriti sa adaugati participanti, apoi faceti click pe butonul ,,Add/remove
users”.

Din lista ,Potential members”, selectati utilizatorii pe care doriti sa 1i adaugati in grup.

Faceti click pe butonul ,,Add” pentru a adauga utilizatorii la grup.

Crearea automata a grupurilor

Grupurile pot fi create automat cu ajutorul butonului ,,Auto-create groups” din Participants > Actions

Menu > Groups.

General

O schema de denumire poate fi creata automat. ,#” este inlocuit cu numere secventiale, iar ,,@” cu

litere. De exemplu: Group @ -> Group A, Group B, ...; Group # -> Group 1, Group 2, ...;

Telefon: +40 0262 226 778 » Fax: +40 0262 226 778
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Puteti specifica:

e Un numar x de grupuri
e Fiecare grupa contind un numar x de membri

Groups Participants Groups ~ Auto-create groups
Auto-create groups

~ General
Maming scheme* (7)
Auto create based on Number of groups j

Group/member count*

+ Group members

Select members with role Student j
Select members from group Group A j
Allocate members Randomly

Prevent last small group

lgnore users in groups

Prevent last small group

HOLISUN

Cand selectati ,Members per group”, in functie de numarul de utilizatori din curs, ultimul grup poate

primi cu mult mai putini membri, decat era de asteptat. Puteti selecta ,,Prevent last small group” pentru

a evita aceasta situatie. Daca ultimul grup va fi mai mic de 70% din dimensiunea asteptata, atunci nu

va fi creat. Membrii ramasi fara grup vor fi repartizati la cele deja create.

»lgnore users in groups” trebuie bifatd pentru a selecta doar membrii pentru noul grup, dintre

utilizatorii care NU sunt deja intr-un grup din curs.

»include only active enrolments” ofera optiunea de a alege daca includeti in grupuri utilizatorii

suspendati.
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Grouping

,Create in grouping” si ,Grouping name” va permite sa creati o noua grupare si sa alocati noile grupuri
create automat la aceasta grupare.

Grupari de grupuri
O grupare este o colectie de grupuriin cadrul unui curs. Utilizarea gruparilor va permite sa directionati
sarcinile catre unul sau mai multe grupuri din curs.

Groups Groupings Overview

Groupings

Grouping Groups Activities  Edit
Class A Mone 0 o X
L)

Create grouping

Adaugarea grupurilor la grupari

n cadrul unui curs accesati sectiunea , Participants”, de unde selectati Actions Menu > Groups;
Deschideti tab-ul ,Groupings”;

Daca este nevoie, creati o noua grupare: ,,Create grouping”;

Faceti click pe iconita ,,Show groups in grouping” din coloana , Edit”;

GoA W e

in pagina ,, Add/remove groups”, selectati grupul (grupurile) din lista ,Potential members” pe
care doriti sa le adaugati la grupare;
6. Selectati butonul ,Add”.

Existing members: 0 Potential members: 3

Group BM >
Group FC

Group S
< Add

W Remove »

Gruparile existente pot fi modificate si / sau sterse folosind pictogramele corespunzatoare din coloana
»Edit” a tabelului din pagina gruparilor.
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Note

Acordarea notelor din pagina activitatii de
yAssignment”

Daca se doreste notarea unor lucrari trimise de cursanti in activitatea , Assignment” (fisier / text online
etc.), cel mai bun loc pentru a introduce aceste note este chiar activitatea in sine.

Din pagina activitatii selectati , View All Submissions”.

Assignment 1

Grading summary

Participants 0

Submitted 0

Meads grading o

Due date Tuesday, 27 October 2015, 12:00 AM
Time remaining 6 days 9 hours

View/grade all submissions

in pagina urmétoare, veti vedea unde puteti adduga note / feedback si veti putea examina lucrérile
studentilor. Tn partea de sus a paginii este o listd drop-down. Aici aveti optiunea de a descirca toate
lucrarile cursantilor.

Grading action

J

Download all submissions E j
View gradebook

Firstname: AIABCDEFGHIJKLMNOPQRSTUVWXYZ
Sunmame: AIABCDEFGHIJKLMNOPQRSTUVWXYZ
Page: 1 2 3 (Next)
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Catalogul de note (,,Grader report”)

Toate notele ale unu cursant, dintr-un curs, pot fi gasite in catalogul de note al cursului sau in ,,Grader
report”. Se poate accesa din blocul din stanga: , Grades”.

Pentru a modifica note in catalog selectati butonul ,, Turn editing on”, din coltul dreapta sus.
Setari note

Setarile pentru notele de curs determina modul in care se afiseaza catalogul de note participantilor la

curs.

Aceasta sectiune poate fi gasita in Grades > Setup > Course grade settings.

Course grade settings

Setup

Course grade settings Preferer

Course settings determine how the gradebook appears for all participants in the course,

* General settings
Aggregation position Default (Last) &
Min and max grades used in Default (Min and max grades as specified in grade item settings) ¢
calculation

Managementul notelor

Grade items

Un articol de nota, ,,Grade item” este o unitate (de obicei o activitate) unde participantii la curs sunt
evaluati printr-o nota. Prin urmare, ,,Grade item” reprezinta un container pentru note si pentru un set
de reguli aplicate acestor note. Regulile afecteaza calculul si afisarea notelor in rapoartele si exporturile

catalogului.

,Grade items” sunt reprezentate prin coloane in catalogul de note.

»Grade items” bazate pe activitati

O serie de activitati, cum ar fi ,Assignment”, ,Workshop”, ,Lesson”, ,Quiz” isi comunica notele
catalogului. Articolul de nota generat poate fi ulterior modificat, direct din ,Grades”, dar atunci, acesta
va fi blocat in cadrul activitatii. De exemplu, a un profesor care a editat in catalogul cursului, o nota
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pentru o activitate ,Assignment” nu va putea sa schimbe acea nota din activitate, decat daca o

deblocheaza din catalog.

Lista unor setari a unui articol de nota bazat pe activitati

e ,Grade to pass” — Specificati nota minima pe care trebuie sa o obtina un cursant pentru a putea
fi considerat ca a trecut.

e ,Grade type”:

@)
@)
@)
©)

»None” —Notarea nu este posibila

»Value” — O valoare numerica cuprinsa intre un minim si un maxim
,Scale” - Calificative

, Text”- Doar feedback

e ,Overall decimal points” — Aceasta specifica numarul de zecimale afisate pentru fiecare nota.

e Hidden” — Stabileste daca acest articol de nota nu va fi vizibil cursantilor

e Hidden until” — O limita de timp dupa care articolul nu va mai fi ascuns cursantilor

e ,locked” — Daca articolul de nota va fi blocat sau nu. Un articol blocat nu mai primeste
modificari de note si setari din activitate

e ,Locked after” - O data dupa care blocarea va avea efect, de obicei dupa data afisarii notelor.
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* Grade item

ftem name From context to readty: Traur

Item info 7]

1D number ©

Grace type © Value @

Scale 0 Use no scale s

Maximum grade (7 100.00

Minimum grade © 0.00

Grage 10 pass 0 0.00

Grade display type © Default {Real) $

Overall decimal ponts © Defautt (2) *
Hidden @

Hidden until £ @ AD ¢ 2012 ® 13 9 ¢ [  Enable
Locked ©

Lock after s I : : s ) ¢ M " Enable

Shaw less...

~ Parent category

Weight adusted ©

Waight (7] 100.0
Extra credit ©
Grade category My first course

=

Grade categories

Notele pot fi organizate in categorii de note. Pentru ca un articol de nota sa fie inclus intr-o categorie,
trebuie setat in configurarile activitati respective, la sectiunea , Grade” campul ,Grade category” cu
categoria dorita.

Pentru a adduga o categorie de nota:

n sectiunea ,Grades” selectati ,Setup”

n sectiunea ,Gradebook setup” selectati butonul ,Add category”
Dati un nume categoriei

Configurati setarile categoriei

Salvati

e RE

Page1 02

Pentru a edita o categorie deja existenta:
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1. Tn sectiunea , Grades” selectati , Setup”
2. Selectatiiconita , Edit” din dreptul categoriei pe care doriti sa o editati
3. Faceti modificarile necesare si salvati

Agregarea notelor

Meniul drop-down al campului de agregare va permite sa alegeti strategia de agregare folosita pentru
a calcula nota finala a unei categorii de note.

Strategia de agregare
Toate notele sunt transformate mai intai in valori procentuale, apoi sunt agregate folosind una dintre
strategiile de mai jos si transformate in final in limita de valori ale articolelor de note din categoria
respectiva (intre minim si maxim).

Media notelor (,,Mean of grades”)

Calculeaza suma tuturor notelor impartita la numarul total de note.

Exemplu: O categorie A (cu nota maxima egalad cu 100) are 3 articole A1, A2 si A3 (cu notele maxime
egale cu 100, 80 si respectiv 10); daca un cursant obtine urmatoarele note A1=70, A2=20 si A3=10
atunci nota totala pentru A se va calcula:

Al -->70/100=0.7, A2 --> 20/80=0.25, A3 -->10/10=1

A: (0.7 +0.25 + 1.0)/3 = 0.65 --> 65/100 --> 65 (nota maximd pentru A este 100).

Media ponderata (,, Weighted mean”)

Fiecare articol de notd poate primi o pondere pentru a-si modifica importanta in media totala. Tn
termeni simpli, nota totald a categoriei va fi egald cu suma notelor fiecarui articol de nota, inmultite
fiecare cu ponderea sa, iar suma respectiva va fi in impartita la suma tuturor ponderilor.

Exemplu:

Al: 70 out of 100 pondere 10, A2: 20 out of 80 pondere 5, A3: 10 out of 10 pondere 3, categoria A:
nota maxima 100

A1 -->70/100=0.7, A2 --> 20/80=0.25, A3 -->10/10=1

A: (0.7*10 + 0.25%5 + 1.0*3)/(10 + 5 + 3) = 0.625 --> 62.5/100 --> 62.5 (din 100)

Media ponderata simpla (,,Simple weighted mean”)
Diferenta fata de media ponderata este ca ponderea fiecarui articol este nota maxima.
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Exemplu:
Al -->70/100, A2 --> 20/80, A3 --> 10/10, max categorie 100:

A: (0.7*100 + 0.20*80 + 1.0*10)/(100 + 80 + 10) = 0.505 --> 50.5/100 --> 50.5 (din 100)

))
~Natural
Aceasta este suma tuturor notelor, proportionate de ponderile lor relative. Nota maxima a categoriei
este suma maximelor tuturor articolelor agregate.

Al 70/100, A2 20/80, A3 10/10, fdrd a forta ponderile:
A: (70 +20 + 10)/(100 + 80 + 10) --> 100/190

Punctaj

Atunci cand se noteaza o activitate, este posibil sa se utilizeze o notare sub forma de scala (calificative),
un punctaj (scara numericd) sau niciuna dintre acestea.

Un profesor poate selecta un punctajul numeric pentru notare, accesand sectiunea , Edit settings” a
unei activitati, de exemplu ,Assignment”, navigand la sectiunea , Grade” si apoi selectand , Point” din
meniul drop-down:

GradE T\“rpe PUirIt r

ergle | Satisfactory v
Maximum points 120

Aceasta actiune va deschide campul ,,Maximum points”, iar profesorul poate introduce punctajul
maxim pentru acea activitate.

Numarul implicit de puncte pe care un profesor il vede atunci cand alege , Point” din meniul , Type”,
este stabilit de administrator in Site administration > Grades > General settings

Grade point maximum 250

This setting determines the maximum grade paint value available in an activity

Grade point defauilt 200
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Urmarirea progresului
Finalizarea unei activitati ,, Activity completion”

Finalizarea activitatii permite profesorului sa stabileasca criterii de finalizare in setarile unei anume
activitati. O casuta cu bifa & apare in dreptul activitatii atunci cand cursantul indeplineste criteriul de
finalizare. Criteriul ar putea fi vizionarea, primirea unui anumit punctaj sau un cursant care il marcheza
manual ca fiind finalizat.

Tn functie de tipul de activitate, exista criterii de finalizare diferite. De exemplu, o pagind poate avea
criteriul de a necesita vizualizare; un test poate avea criteriul de a primi nota, in timp ce un forum ar
putea avea criteriul de a solicita postari / discutii / raspunsuri.

Activity completion

Completion tracking (3} Do not indicate activity complation v
Require view Student must view this activity to complete it
Require grade (3 Student must receive a grade to complete this activity

Expect completedon @ |11 + | October + |/2011 + ||_Enable

Activity completion

Completion tracking (3 Do not indicate activity completion v
Require view | Student must view this activity to complete it
Require grade (@) Student must receive a grade to complete this activity
Require posts | Student must post discussions or replies: 1
Require discussions | Student must create discussions: 1
Require replies | Student must post replies: |1
Expect compietedon @ | 1° August 2011 Enable

Activity completion

Completion fracking | Students can manually mark the activity as completed |~ |

Require view | [Student must view this activity to complete it
Require grade @ Student must receive a grade to complete this activity

Student must submit to this activity to complete it
Expect completedon |22~ | | November 2012 |~ | CEnable
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Require view Student must view this activity to complete it

Require grade Student must receive a grade to complete this activity

Require passing grade @ Require passing grade Or all available attempts completed

Expect completed on 24 v | October v 2014 ~ Enable

,Completion tracking”

e Do not indicate activity completion” — nu va afisa casuta pentru bifa langa activitate
e ,Students can manually mark the activity as completed” — cursantii marcheaza casuta de bifa
cu finalizat

e ,Show activity as complete when conditions are met” — criteriile de finalizare selectate trebuie
sa fie ndeplinite Thainte casuta de bifa sa fie marcata automat de sistem

Require view

Cand acest criteriu este activat, elevii trebuie sa vizualizeze activitatea, adica sa faca click pe link-ul ei
pentru a fi considerata finalizatd. Nu ar trebui sa activati conditia ,,Require view” daca aveti alte criterii
- acest lucru aglomereaza server-ul si este putin probabil ca un cursant sa poata indeplini orice alte
conditii fara a vizualiza activitatea.

Require grade

Cand acest criteriu este activat, cursantii trebuie sa obtind o nota la activitate pentru a o finaliza. De
exemplu, un test va fi marcat finalizat imediat ce utilizatorul trimite raspunsurile (atat timp cat nu
contine intrebari de tip eseu).

Nu conteaza cat de bine s-a descurcat cu cursantul. Obtinerea oricarei note va marca activitatea
finalizata.

Necesita nota de trecere

Daca o nota de trecere este setata pentru test, atunci se poate seta ca testul sa fie considerat finalizat
odata ce cursantul obtine o nota de trecere.

Daca este permis un anumit numar de incercari, testul poate fi finalizat odata ce cursantul le-a facut
pe toate (chiar daca, de exemplu, nu au obtinut nota de trecere).

Retineti ca ,,Require grade” trebuie sa fie setata, precum si ,,Require passing grade”.

Setari de finalizare a activitatii ,Lesson”
Urmatoarele conditii sunt specifice activitatii ,,Lesson” (pe langa cele standard):
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Require end reached Student must reach the end of lesson page to complete this activity

Require time spent Student must do this activity at least for O minutes  *

»Require end reached”: Pentru ca lectia sa fie marcat finalizata, cursantul trebuie sd ajunga la
ultima pagina a lectiei.

»Require time spent”: Pentru ca lectia s3 fie finalizat3, cursantul trebuie sa petreacd pe paginile
lectiei un timpul specificat de profesorul in aceasta conditie. Daca vor termina lectia mai devreme, vor
primi o alerta care spune ca nu au atins timpul minim acceptabil si ar trebui sa repete lectia.

Learn
Congratulations
- end of lesson reached

You completed this lesson in 8 mins 2 secs.
which is less than the required time of 30 mins.
You might need to attempt the lesson again

Your score is 1 (out of 1)
Your current grade is 100.0 out of 100

Return View grades

Setari de finalizare a activitatii ,Assignment”
»Student must submit to this activity to complete it”

Aceasta conditie Tnseamna ca o activitate ,Assignment” poate fi considerata finalizata odata ce
cursantul a depus-o.

Setari de finalizare a activitatii ,Forum”
»Require posts”

Pentru ca forumul sa fie marcat drept ,finalizat”, cursantul trebuie sa inceapa o discutie sau sa
raspund3 la o discutie. Tn casetd pot fi specificate numarul total de postari pe care trebuie s le faca.

»Require discussions”

Cursantul trebuie sa inceapd o temd de discutie. Tn casetd poate fi specificat numarul de postari pe care
trebuie sa le faca. Notd: aceastd conditie nu poate fi satisfacutd folosind forumurile de tipul ,Single
simple discussion” sau ,,Q and A”, deoarece cursantii nu pot crea discutii in cele doud tipuri.
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»Require replies”

Cursantul trebuie sd rdspunda la o discutie. in casetd poate fi specificat numarul de postdri pe care
trebuie sa le faca.

,Expect completed on”
Cand este introdusa o data aici pentru o activitate de tip Forum sau pentru o resursa, ,Page” sau
»Folder”, data de finalizare preconizata va fi afisata pe noul bloc de prezentare a cursului.

Show activity as complete when conditions are met $

¢ Student must view this activity to complete it

un

Mav ¢ 2017 ¢ £ @ Enable

o

Today

2

Next 7 days

Finalizarea unui curs , Course completion”

Activare ,Course completion”
Un administrator poate activa ,Course completion” pe platforma, selectand ,Enable completion
tracking” din Site administration > Advanced features.

Un profesor poate apoi sa activeze ,,Course completion” pentru cursul sau, setand ,, Enable completion
tracking” pe ,Yes” in pagina de editare a setarilor curaului. (Actions Menu > Edit settings > Completion
tracking > [expand the category] > Yes > Save and display)

Un link de finalizare a cursului va aparea in meniul ,Actions Menu”, din dreapta sus. Daca faceti clic pe
acesta, veti afisa trei file:
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Bulk edit activity completion

G

Setari de finalizare a cursului
General

Alegeti cum doriti sa marcati cursul finalizat — daca doriti ca unele ,Any” sau toate ,,All” conditiile sa fie
luate Tn considerare pentru finalizarea cursului.

Condition:Activity completion
Bifati casetele activitatilor pe care doriti sa le considerati pentru finalizarea cursului.

Condition:Completion of other courses

Condition: Completion of other courses

Course completion is not enabled for any other courses, so none can be displayed. You
can enable course completion in the course settings.

Condition: Completion of other courses

Courses ' Sciences / Earth Sciences
available

Mote: Course completion conditions must be set for a course to appear in the abaove list.

Aceasta setare va permite sa puneti o conditie de finalizarea a unui alt curs, pentru finalizarea cursului
in care lucrati in prezent. Acest lucru nu blocheaza cursantul din cursul actual; inseamna pur si simplu
ca cursul actual nu va fi marcat complet pana cand primul curs nu a fost marcat complet. Astfel,
finalizarea cursului actual depinde de finalizarea unui curs anterior. Selectati unul sau mai multe cursuri
in cdmpul ,,Courses available box”.

Nota: Pentru a elimina un curs din listd, dacd nu mai este necesar, apdsati CTRL+click pe cursul
evidentiat si acesta va fi dezactivat.

Condition: Date

Puteti seta o data dupa care cursul va fi finalizat.
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Condition: Enrolment duration

Puteti alege un numar de zile de la inscriere la care cursul va fi finalizat.
Condition: Unenrolment

Cursul va fi marcat finalizat dupa ce cursantul va fi dezactivat din curs.
Condition: Course grade

Puteti seta o nota de trecere pentru curs.

Condition: Manual self-completion

Daca acest criteriu este activat, un cursant isi poate marca singur cursul finalizat din blocul ,Self
completion”.

SELF COMPLETION

Complete Course...

Condition: Manual completion by others

Utilizatorii cu anumite roluri pot marca cursul ca fiind finalizat daca rolul lor este bifat aici. , ALL”
inseamna ca fiecare rol trebuie sa marcheze cursul finalizat; ,,ANY” inseamna ca va fi marcat ca finalizat
dupa ce unul dintre rolurile bifate aici I-a marcat.
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